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Lab Overview

This lab contains the following exercises:-
e Discover Intel vPro client
¢ Install and Configure ConfigMgr Out of Band Management Component

e Configure ConfigMgr for Out of Band Management Management console
Operations

e Provision Intel vPro client Management Controller using ConfigMgr Agent
e Simple Intel vPro client management using AMT WebUI

e On-demand remote power control of Intel vPro client

e Retrieve real-time Intel vPro client hardware inventory information

¢ Remote BIOS Setup Access with Intel vPro clients using Serial Over LAN

e Remote Boot Intel vPro clients with Remediation Software Using IDE
Redirection

e Enable Hardware KVM on Intel vPro client

e Hardware KVM with RealVNC Viewer Plus and Intel vPro client

e Hardware KVM with Microsoft System Center and Intel vPro client
e Using Microsoft PowerShell with Intel vPro client

e Scheduled Software Deployment deployment using Intel vPro remote power
control

e On-demand Operating Systems deployment using Intel vPro Forced PXE Boot
e Scheduled Operating System deployment using Intel vPro remote power control
e Re-Provision Intel vPro client Management Controller

e Un-Provision Intel vPro client Management Controller
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Lab Materials

e Step by Step Lab Instruction Guide (this document)

e Intel vPro Technology PC

e Desktop or Laptop Computer hosting Virtual Machine Environment
e Pre-Configured Virtual Machines

Lab Environment

e Windows domain is VPROLAB
e DNS domain is VPROLAB.COM
e Administrator password is P@sswOrd
e Network is 192.168.11.0/24
Virtualized Machine Environment
A
Q % %
[¢] Q
I
@ S S S
Domain Controller ConfigMgr Server
Intel AMT Client Virtual Machine Virtual Machine
vproclient.vprolab.com dcO0.vprolab.com sccm.vprolab.com
Dynamic IP 192.168.11.2 192.168.11.20

Figure 1 - Standard ConfigMgr Lab Schematic
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Lab Instructions

As you complete each procedure, use the O tick box provided to record your progress
and avoid missing any procedures

Lab Startup

e Start the Virtual machine for the Domain Controller and logon as Administrator

e Start the Virtual machine for the ConfigMgr server and logon as Administrator

O Tick this box when you have completed all steps in this procedure
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Discover Intel vPro Clients

IMPORTANT: Before proceeding with this exercise, ensure the following pre-requisites
have been completed; the Intel vPro client should be joined to the VPROLAB domain,
the client should have the ConfigMgr agent installed, the client firewall should be
configured for ConfigMgr client agent compatibility, the client should be discovered in
ConfigMgr and collection membership should be updated for all collections

Your instructor will be able to help you complete these steps

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

e Discover Intel vPro Clients

Discover Intel vPro Clients

HELPFUL HINT: The ConfigMgr agent detects Intel vPro capability and reports this
information during a normal Hardware Inventory cycle. This information should be used
to construct collection membership rules identifying Intel vPro clients. Other discovery
methods including Network Discovery and on-demand Out of Band Management
Controller discovery from the ConfigMgr console can be unreliable

Intel vPro specific information can be viewed using Resource Explorer to inspect the
AMT Agent hardware component

e Onthe SCCM server, click Start > All Programs > Microsoft System Center >
Configuration Manager 2007 > ConfigMgr Console

e Expand Site Database > Computer Management > Collections and right-click
Collections. Click New Collection to open the New Collection Wizard

e At the General screen, enter All vPro Systems in the Name field and click Next

o At the Membership rules screen, click the database button to open the Query Rule
Properties dialog

o At the Query Rules Properties dialog, enter a name for the query in the Name
field. For this lab use the name All vPro Systems Query
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Select System Resource for the Resource class field and click Edit Query
Statement...

At the All vPro System Query Statement Properties dialog select the Criteria tab
and enter a criteria statement AMT Agent.Provision State is equal to 0 or AMT
Agent.Provision State is equal to 1 or AMT Agent.Provision State is equal to
2

All vPro Systems Query Statement Properties x|

You can spedify criteria to narrow the query and limit the results that are
returned.

Criteria: lﬁ'l |:1:“]|i<]| &|| !I

or
AMT Agent.Provision State is equal to 1
or
AMT Agent.Provision State is equal to 2

Show Query Language | OK I Cancel I Help |

Figure 2 - All vPro Systems Collection Query Criteria

Click OK to close the Query Statement Properties dialog and click OK to close
the Query Rule Properties dialog. Click Next

At the Advertisements screen, click Next
At the Security screen, click Next
At the Confirmation screen, click Close to close the New Collection Wizard

Select the All vPro Systems collection just created and create two new sub-
collections named All Un-Provisioned vPro Systems and All Provisioned vPro
Systems. The membership query statements for these two sub-collections should
be named All Un-Provisioned vPro Systems Query and All Provisioned vPro
Systems Query respectively and the criteria statements should be (AMT
Agent.Provision State is equal to 0 or AMT Agent.Provision State is equal to
1 or AMT Agent.Provision State is equal to 2) and (System Resource. AMT
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Status is NULL or System Resource. AMT Status is not equal to “3”)” and
System Resource., AMT Status is equal to “3” respectively

You can specify criteria to narrow the query and limit the results that are
returned.

Criteria: | @l )| &IJ : I

AMT Agent.Provision State is equal to 0
or
AMT Agent.Provision State is equal to 1
or
AMT Agent.Provision State is equal to 2

and
System Resource. AMT Status is NULL

or
System Resource.AMT Status is not equal to "3”

Show Query Language l OK I Cancel | Help I

Figure 3 - All Un-Provisioned vPro Systems Collection Query Criteria

All Provisioned vPro Systems Query Statement Proper 5]

General Criteria IJoins |

You can specify criteria to narrow the query and limit the results that are
returned.

Criteria: D ﬁ‘l XI i})l ol &IJ ! I

System Resource. AMT Status is equal to "3°

Show Query Language l OK | Cancel | Help I

Figure 4 - All Provisioned vPro Systems Collection Query Criteria

Select the All vPro Systems collection, right-click and click View >
Add/Remove columns... At the Add/Remove columns dialog, add columns for
AMT Status and AMT Version. Click OK
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e Select the All vPro Systems collection and update the collection membership for
this collection and all sub-collections. The All vPro Systems and All Un-
Provisioned vPro Systems collections should contain the un-provisioned Intel
vPro client and the All Provisioned vPro Systems collection should be empty. If
all the collections are empty perform a hardware inventory discovery cycle and
once this is complete update the collection membership again

HELPFUL HINT: After Intel vPro clients have been discovered, the Intel AMT
firmware versions and PC BIOS versions should be evaluated to determine if any updates
are available or required. Updates are available from PC OEM’s and can be distributed as

a software update package to avoid visiting clients

O Tick this box when you have completed all steps in this procedure
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Install and Configure ConfigMgr Out of Band Management
Component

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

e Create Active Directory Security Group for ConfigMgr Primary Site Servers

Create Active Directory OU for Client Management Controller Objects
e Create Client Management Controller Server Certificate Template

e Configure Issuing Certificate Authority to Allow Revocation of Client
Management Controller Certificates

¢ Install ConfigMgr Out of Band Service Point
e Configure Out of Band Management Component

e Configure Site Parameters to Use Secure Remote Power Control

Create Active Directory Security Group for ConfigMgr Primary Site
Servers

e On the domain controller, click Start > All Programs > Administrative Tools >
Active Directory Users and Computers

e Expand the vprolab.com domain and select the Users container. Right-click the
Users container and click New > Group
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Q Active Directory Users and Computers :J.'?.I.’g

<) Fle Action View Window Help

JREDS

s | AamElieXEFRR|2E

QG YQa

(L saved Queries

@ Active Directory Users and Computer BTSSP EEE

Mew Window from Here

InetOrgPerson
MSMQ Queue Alias

& @ vprolab.com Name: - Type De‘scTiEtion - I
(3 Buiin € Administrator  User Built-in account for admini...
(2 Computers mCert Publishers Security Group ...  Members of this group are...
(@) Domain Controlers €TCERTSYC D...  Security Group ...

(1 ForeignSecurityPrincipals €33 ConfigMgr IL...  Security Group ...
(2 LostandFound QDHCP Admini... Security Group ... Members who have admini...
(Z1 NTDS Quotas mDHCP Users Security Group ... Members who have view-...
(] Program Data @DnsAdmins Security Group ... DNS Administrators Group
(1 System mDnsUpdatePr. .. Security Group ...  DNS clients who are permi...
"jm" Delegate Control = ormain Admins Security Group ...  Designated administrators. ..
Fii:?‘.a ©onire. Emain Com... Security Group ...  All workstations and serve...
2 pmain Cont... Security Group ...  All domain controllers in th...
' » Computer loup All domain guests
All Tasks »  Contact oup All domain users
view R oup Designated administrators. ..

Members in this group can...
Built-in account for guest ...

Refresh Printer oup Group for the Help and Su...
Export List... User oup 115 Worker Process Group
= Shared Folder Built-in account for anony...
Fropertes User Built-in account for Intern...
Help btgt User Key Distribution Center Se...
AS and IAS ... Security Group ...  Servers in this group can ...
mSchema Admins  Security Group ...  Designated administrators...
%SUPPORTJS... User This is a vendor's account ...
mTeInetCIients Security Group ... Members of this group ha...
K | |
[Create a new object...

Ejstartl J @ &

J [@ Active Directory User... 1 untitled - Paint |

|
| | @& 1024

Figure 5 - Active Directory Users and Computers New Group

e At the New Object — Group dialog, enter ConfigMgr Primary Site Servers into
the Group name field and set Group type to Security. Click OK to create the

group

New Object - Group

@ Createin:  vprolab.comfUsers

Group name:

IConfigMgr Primary Site Servers

Group name {pre-Windows 2000):

| ConfigMar Primary Site Servers

Group scope

" Domain local
& Global

£ Universal

Group type
& Security
¢ Distribution

o |

Cancel I

Figure 6 - ConfigMgr Primary Site Servers Group
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In Active Directory Users and Computers, right-click the ConfigMgr Primary
Site Servers group just created and click Properties

At the ConfigMgr Primary site Servers Properties dialog, click the Members tab,
click Add... and add the SCCM member server to this group. If the SCCM
member server is not found then click Object Types... and ensure the Computers
object type is checked before retrying. Click OK once the SCCM member server
is added to this group

ConfigMgr Primary Site Servers Propetties ll 1]

General Members | Member Dfl Managed Byl Dbiecll Securily]

Members:

| Name | Active Directory Folder |
@ SCCM vprolab.com/Computers

oK I Cancel | Apply |

Figure 7 - ConfigMgr Primary Site Servers Group with SCCM Member Server

Shutdown and reboot the SCCM member server so that it picks up the new group
membership

Do not close the Active Directory Users and Computers console

O Tick this box when you have completed all steps in this procedure

Create Active Directory OU for Client Management Controller Objects

IMPORTANT: When a single ConfigMgr site provisions Intel vPro clients in multiple
domains, an identically named OU must appear in each domain. During provisioning
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ConfigMgr determines the domain containing the Intel vPro client and creates objects
representing the Management Controller in OU for the domain containing the client

e At the Active Directory Users and Computers console, right-click the
vprolab.com domain and click New > Organizational Unit

-i81x
é File Action Wiew Window Help ’_J._l- 8 x|

- am i B XTRER 2E BB YE D
< Atve Diectry Usersand Conputer

-] Saved Queries

& Name: Type Description ]
(1 Buti Delegate Contraol... v User Built-in account for admini...
(3 Com Find... ers Security Group ...  Members of this group are...
@] Dom.  Connect to Domain... . Security Group ...

([ Fore  Connect to Domain Controller... 1... Security Group ...
(1 Losts  Raise Domain Functional Level... ¥i... Security Group ...
(LI NTDS  Operations Masters... i Security Group ...  Members who have admini...
[ Prog = Members who have view-...
& Eompe DNS Administrators Group
@ ey DNS clients who are permi...
New Window from Here Group Designated administrators...
s InetOrgPerson .
3 All workstations and serve...
Refresh SMQQuue G All domain controllers in th...
Organizational Unit 5
Properties . All domain guests
e Printer 3
All domain users
£ — il Designated administrators. ..
mGroup Polim._ Members in this group can...
Guest User Built-in account for guest ...
mHelpServices... Security Group ... Group for the Help and Su...
mIIS_WPG Security Group ... IIS Worker Process Group
ﬂ IUSR_DCO User Built-in account for anony...
€ 1wam_pco User Built-in account for Intern...

%krbtgt User Key Distribution Center Se...
mRAS and IAS ... Security Group ...  Servers in this group can ...
mSchema Admins  Security Group ... Designated administrators. ..
%SUPPORT_SS... User This is a vendor's account ...
!ﬂTelnetCléents Security Group ... Members of this group ha...

K —| |

[Create anew object...

|
wstartl J @ e J w untitled - Paint "él\(tive Directory User... J | @ 12:57

Figure 8 - Active Directory Users and Computers New Organizational Unit

e At the New Object — Organizational Unit dialog, enter Out of Band
Management Controllers into the Name field and click OK to create the
organizational unit
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New Object - Organizational Unit 3

[ @ Createin:  vprolab.com/

Name:

IDul of Band Management Controllers|

o]

Cancel

Figure 9 - Out of Band Controllers Organizational Unit

Right-click the Out of Band Management Controllers organizational unit just

created and click Properties

17

At the Out of Band Management Controller Properties dialog, click the Security

tab and click Advanced

Out of Band Management Controllers Properties™ ll 5]

General | Managed By | Object Secuiity | COM+ | Group Policy |

Group or user names:
ﬂi Account Operators (VPROLAB\Account Operators) j

ﬁi Administrators [VPROLAB\Administrators)
ﬁ,’: Authenticated Users
ﬁi ConfigMar Primary Site Servers (VPROLABAConfigMar Primary S...

m Domain Admins [YPROLAB\Domain Admins)
- R e e =
Add... | BRemove I
Permissions for ConfigMar Primary Site
Servers Allow Deny
Full Control o =2
Read O
Write O
Create All Child Objects O
Delete All Child Objects O
Generate Resultant Set of Policy(Logging) O |
For special permissions or for advanced settings, Advanced |
click Advanced. =

oK I Cancel l Apply
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At the Advanced Security Settings for Out of Band Management Controllers
dialog, click Add... and add the ConfigMgr Primary Site Servers group
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e At the Permission Entry for Out of Band Management Controllers dialog, for the
Apply onto field select This object and all child objects and for Permissions
check Allow Full Control. Click OK

21X

Name:
Apply onto: IThis object and all child objects :]
Permissions: Allow Deny

Full Control o 2

List Contents O

Read &ll Properties O

White Al Properties O

Delete O

Delete Subtree O

Read Permissions O

Maodify Permissions O

Modify Owner O

Al Validated Writes O

&Il Extended Rights O

Create Al Child Objects O

P olote AN CLAD AL -be (] m l‘
o Apply these permissions to objects and/or Clear &ll I

containers within this container only
OK I Cancel |

Figure 11 - Organizational Unit Advanced Permissions

e Click OK to close the Advanced Security Settings dialog
e Click OK to close the Out of Band Management Controller Properties dialog

e Close the Active Directory Users and Computers console

O Tick this box when you have completed all steps in this procedure

Create Client Management Controller Server Certificate Template

e On the domain controller, click Start > All Programs > Administrative Tools >
Certificate Authority

e Expand vProLab Enterprise Issuing CA, right-click Certificate Templates and
click Manage to load the Certificate Templates management console

© Copyright 2011 Intel Corporation



19

e At the Certificate Templates console, in the list of templates displayed in the right
hand console pane, right-click the Web Server entry and click Duplicate

Template

IMPORTANT: When using a certificate authority based on Windows Server 2008,
select a certificate template that is compatible with Windows Server 2003

File  Action

 certtmpl - [Certificate Templates]

View Window Help

= @R 2

Certificate Templates

Template Display Name /

Directory Email Replication
Domain Controller

Domain Controller Authentication

EFS Recovery Agent

@Enrollment Agent

Enrollment Agent (Computer)

@Exchange Enrollment Agent (Offline request)

@Exchange Signature Only

Exchange User

@IPSac

IPSec (Offline request)

Key Recovery Agent

@RAS and IAS Server

Root Certification Authority

Router (Offline request)

@Smartcard Logon

@Smartcard User

@Subordinate Certification Authority

Trust List Signing
User

@User Signature Only

7 web Server

@Workstation Authenticatic

7 I All Tasks
Using this template as a base, creates a template that supports Windows ~ Properties
Help

=]
| =181 x|
l Minimurm Supported CAs | Version | Autoenrollment ;]
Windows Server 2003, En... 115.0  Allowed
Windows 2000 4.1 Mot allowed
Windows Server 2003, En... 110.0  Allowed
Windows 2000 6.1 Mot allowed
Windows 2000 4.1 Mot allowed
Windows 2000 5.1 Mot allowed
Windows 2000 4.1 Mot allowed
Windows 2000 6.1 Mot allowed
Windows 2000 7.1 Mot allowed
Windows 2000 8.1 Mot allowed
Windows 2000 7.1 Mot allowed
Windows Server 2003, En... 105.0  Allowed
Windows Server 2003, En... 101.0  Allowed
Windows 2000 5.1 Mot allowed
Windows 2000 4.1 Mot allowed
Windows 2000 6.1 Mot allowed
Windows 2000 11.1 Mot allowed
Windows 2000 5.1 Mot allowed
Windows 2000 3.1 Mot allowed
Windows 2000 3.1 Mot allowed
Windows 2000 4.1 Mot allowed
iaat'iys 2000 Mot allowed
ows Server 2003, En 101.0  Allowed =
’ |
ion CAs I

Figure 12 - Duplicate Certificate Template

o At the Properties of New Template dialog, click the General tab and enter
ConfigMgr AMT Web Server Certificate into the Template display name

field
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Properties of New Template - . e 3

Issuance Requirements ] Superseded Templates ] Extensions I Security |
General Request Handiing | Subject Name

Template display name:
IConfigMgr AMT Web Server Certificate

Minimum Supported CAs:  Windows Server 2003, Enterprise Edition

After you apply changes to this tab, you can no longer change the template
name.
Template name:

ConfigMarat TwebServerCertificate

Walidity period: Renewal period:

I 2 Iyears % I I 6 Iweeks . I

I iPublish certificate in Active Directon

[~ Do not automatically reenroll if a duplicate certificate exists in Active
Directory

oK I Cancel I Apply I

Figure 13 - Management Controller Server Certificate Template General Tab

At the Properties of New Template dialog, click the Security tab. Select the
Domain Admins group and uncheck Enroll permissions for this group. Select the
Enterprise Admins group and uncheck Enroll permissions for this group

Click Add... and add the ConfigMgr Primary Site Servers group. Select the

ConfigMgr Primary Site Servers group and check Read and Enroll permissions
for this group. Click OK
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General I Request Handling | Subject Name |
Issuance Requirements | Superseded Templalesl Extensions ~ Security

Group or user hames:

Q Administrator [VPROLAB\Administrator)

!ﬁ Authenticated Users

ﬂi Confighar Primary Site Servers [VPROLABAConfighar Primary Site ...
ﬂi Domain Admins [YPROLAB\Domain Admins)

gi Enterprise Admins [VPROLABA\Enterprise Admins)

add.. | Bemove |

Permissions for Confighiar Primary Site
Servers Allow Deny

Full Control O O

Read O

Write O

Enrall O

Autoenroll O
For special permissions of for advanced settings, Advanced I
click Advanced. —

oK | Cancel I Apply I

Figure 14 - Management Controller Server Certificate Template Security Tab

Close the Certificate Templates management console

At the Certification Authority management console, right-click Certificate
Templates and click New > Certificate Template to Issue
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{& certification Authority , =10] x|

File Action Yiew Help
co @B 2m > =

@ECertiﬁcation Authority (Local) | Mame l Description l
= @ vProLab Enterprise Root CA @vaLab Enterprise Root CA Certification Authority
(] Revoked Certificates
(1] Issued Certificates
(1 Pending Requests
(1 Failed Requests

=] Cetical Manage I

Certificate Template to Issue

Refresh

Help

IEnabIe additional Certificate Templates on this Certification Authority ]

Figure 15 - Certificate Authority Certificate Template to Issue

¢ Inthe Enable Certificate Templates dialog, select the ConfigMgr AMT Web
Server Certificate template just created and click OK to enable certificates to be

created based on this template

Select one or more Certificate Templates to enable on this Certification Authority
Name | Intended Purpose -
Authenticated Session Client Authentication
Ca4 Exchange Private Key &rchival
CEP Encryption Certificate Request Agent
ode Signing Code Signing
Configiar AM erver Certificate S Authentication o
Cross Certification Authority <Al
Enrollment Agent Certificate Request Agent
Enroliment Agent (Computer) Certificate Request Agent
Exchange Enrollment Agent (Offine request] Certificate Request Agent
Exchange Signature Only Secure Email
[SAF wrhanae | 1ser Seriie Fmail =
oK I Cancel I

Figure 16 - Enable Certificate Templates Dialog

e Do not close the Certification Authority console
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O Tick this box when you have completed all steps in this procedure

(Optional) Configure Issuing Certificate Authority to Allow Revocation
of Client Management Controller Certificates

HELPFUL HINT: Provisioning and Out of Band Management operations can still be
performed if this step is not completed but certificates issued to Management Controllers
will not be automatically revoked when the Management Controller is un-provisioned

e At the Certification Authority console, right-click vProLab Enterprise Issuing
CA and click Properties

e At the CA Properties dialog, click the Security tab
e Click Add... and add the ConfigMgr Primary Site Servers group. Select the

ConfigMgr Primary Site Servers group and check Issue and Manage
Certificates and Request Certificates permissions for this group. Click OK

vProLab Enterprise Issuing CA Properties 21|
General I Policy Module I Exit Module I Extensions ] Storage |

Certificate Managers Restrictions I Auditing I Recovery Agents  Security

Group or user names:

ﬁi Administrators [VPROLAB\Administrators)

@ Authenticated Users

!ﬁ ConfigMar Primary Site Servers [(YPROLABConfighdar Primary Site ...
€7 Domain Admins (VPROLABAD omain Admins)

!ﬁ Enterprise Admins [VPROLABA\Enterprise Admins)

Add... | Remove l
Permissions for ConfigMar Primary Site
Servers Allow Deny
Read O O
Issue and Manage Certificates O
Manage C& O O
Request Certificates O

oK I Cancel I Apply I

Figure 17 - Certificate Authority Security Properties

e Close the Certification Authority console
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O Tick this box when you have completed all steps in this procedure

Install ConfigMgr Out of Band Service Point

e Onthe SCCM server, click Start > All Programs > Microsoft System Center >
Configuration Manager 2007 > ConfigMgr Console

¢ Inthe Configuration Manager console, expand System Center Configuration

Manager > Site Database > Site Management > ISW > Site Settings > Site
Systems

E§ Configuration Manager Console ] 3

=10l x|
%) Eile Action View Window Help | =8 x|
& = | |2
——————————————————
;J System Center Configuration Man \ASCCM 6 items found Actions
= \.; §ite LG A e Y —— | \\sceM A
== ] Site Management Look for: I LI in IAII Columns ;] Find Kow | Clear, |
(=) 15w - Intel Swindon vI B New Roles
=L@ Site Settings
> Start »
£ Addresses Roles | Type | ®
i) Boundaries E‘ EEConfigMgr component server Server ‘@ Give Feedback
o2} Clrent Agents Hj ConfigMgr distribution point Server View
{5 Client Installat Hj ConfigMgr management point Server
{3 Component Cc gj Configgr site server Server New Window from Here
B g AC\::::;:'S:ES H} Confighar site system Server Refresh
e Hj ConfigMgr site database server Server

2 Discovery Met
[ senders
3 Site Maintenar
{23 Status Filter R
{2 Status Summa
=[5 Site Systems

(5 yiscem

& \_-5‘ Computer Management
-1 System Status
el
[#

2 Help

#-[22 Security Rights
73 Tools

KN — |

Figure 18 - Configuration Manager Console Showing Site Systems
¢ Right-click the \SCCM site system server and click New Roles to launch the

New Site Role Wizard

e On the General page, click Next
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On the System Role Selection page, check Out of band service point and click
Next

On the Out of Band Service Point page, change any default settings you require
for how out of band transmission packets are sent. For this lab leave the settings at
their default value and click Next

On the Summary page, review the settings in the Details window and click Next

On the Confirmation page, verify the wizard completed successfully and click
Close

Do not close the Configuration Manager console

HELPFUL HINT: After installing the ConfigMgr Out of Band Service Point, the log
file C:\Program Files\Microsoft Configuration Manager\Logs\AMTSPSetup.Log can
be reviewed to inspect the success or failure of the installation

O Tick this box when you have completed all steps in this procedure

Configure Out of Band Management Component

In the Configuration Manager console, expand System Center Configuration
Manager > Site Database > Site Management > ISW > Site Settings >
Component Configuration

In the Component Configuration pane, right-click Out of Band Management and
click Properties
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EQ Configuration Manager Console

=10l x]

g,] File Action View Window Help

| =l1

e = | @ @m

=] w;‘ I5W - Intel Swindon + @D Give Feedback
=L@ Site Settings

13 Addresses

View

Item Name

B A SN, Component Configuration 6 items found Actions
= site Qatahase asw-scem/m—————— ————— ————————————————————————— Component Configuration &
[=1-1) Site Management Look For: | :] in !AII Columns L] Find How ] Clear |

-

@ Boundaries Out of Band Management P New Window from Here
] leent Agents || g pManagement Point Component GRiGE Refresh
“1? Client Installe || 2% oftyare Distribution
L Component ¢ |81 Software Update Point Componer D Help
-5 Certificates (ip .
A& Accounts {29 Status Reporting Out of Band Management &
iR .
Ba L% System Health Validator Paint Component
4 Discovery Me Refresh
2y Senders = :
- Site Maintens Properties
{23 status Filter | 2@ Hel
i P
{7 Status Summ
[#-1g) Site Systems Description
g Computer Management Settings for configuring components
1) System Status that manage out of band
2 Security Rights management controllers,
#-[33 Tools
K S L]

[Opens the properties dialog box for the current selection, ]

4/ start J @ & J 5 configuration Manag... [ Microsoft Management CI 14 untitled - Paint I J () @ 14:58

Figure 19 - Configuration Manager Console Showing Component Configuration

¢ Inthe Out of Band Management Properties dialog, click the General tab

e Set the Active Directory container field to the Out of Band Management

Controllers organizational unit created earlier using the Browse... button. For

this lab the Active Directory container distinguished name (DN) is

LDAP://OU=0ut of Band Management Controllers,DC=vprolab,DC=com

e Configure a strong local MEBx Account password that will be applied to client
Management Controllers during provisioning using the Set... button. For this lab

use the password P@sswOrd

e If using Out of Band provisioning, check Allow out of band provisioning to
allow ConfigMgr to respond to ConfigMgr Out of Band provisioning requests

from clients

e If using Out of Band provisioning, check Register ProvisionServer as an alias

in DNS to create a CNAME record in DNS to allow client Management

Controllers to locate ConfigMgr during the ConfigMgr Out of Band provisioning

process
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HELPFUL HINT: Allow out of band provisioning and Register ProvisionServer as
an alias in DNS do not need to be checked if ConfigMgr Out of Band provisioning is not
being used

e Set the Provisioning certificate field to the provisioning certificate using the
Browse... button. For this lab the provisioning certificate is contained in the file
Provisioning Certificate.pfx located on the desktop and the certificate private key
password is P@sswOrd

e Set the Certificate template field to the client Management Controller server
certificate template created earlier using the Select... button. For this lab the
Issuing CA is DCO.vprolab.com and the AMT certificate template is ConfigMgr
AMT Web Server Certificate

Out of Band Management Properties X x|
802.1Xand Wireless | Audit Settings |  Provisioning Schedule |
General l AMT Settings ] Provisioning Settings I

L@ Out of Band Management Configuration
3=

Spedify the settings required by computers managed by out of band

management.
—Provisioning settings
Active Directory container:
[unagement Controllers,DC=vprolab,DC=com Browse...
MEBx Account:
[admin Set...

[~ Allow out of band provisioning

AMT provisioning port (TCP):

o Register ProvisionServer as an alias in DNS

—Certificates
Provisioning certificate:

IGB, WILTSHIRE, SWINDON, INTEL CORPOR Browse...

Certificate template:

[vPrnLab Enterprise Issuing CA/ConfigMar AM Select...

oK | Canced | sy | Hep |

Figure 20 - Out of Band Management Properties General Tab

e Click Apply to save the General tab settings

e Inthe Out of Band Management Properties dialog, click the AMT Settings tab
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e Click the * button to add a Windows domain user or group to the AMT user
accounts list. The domain users or groups added to this list will have access to the
Management Controller on all clients provisioned by this Out of Band Service
Point. For this lab use VPROLAB\Domain Admins as the group with
permissions to PT Administration features. Click OK to close the AMT User
Account Setting dialog

|
Specify the domain account or security group that has permissions to perform
operations on the AMT-based computers.
Account or security group:
Example: domainigroup
IVPROLAB\DomaIn Admins Browse. ..

Supported AMT features:

OK I Cancel Help

Figure 21 - VPROLAB\Domain Admins AMT User Account Setting

HELPFUL HINT: Using Active Directory security groups in the AMT User Accounts
list allows IT administrators to control access to Management Controllers through group
membership thus avoiding re-provisioning clients to add or remove user access

e (Optionally) set Default IDE-redirect image to an ISO or floppy disk image
located on a network share or to a local physical CD-ROM or floppy drive
containing media to be booted during IDE redirection operations

e Set the Manageability is on in the following power state field to Always on
(S0-S5)

e Check Enable Web Interface to enable the Intel AMT WebUI on the
Management Controller

e Check Enable serial over LAN and IDE redirection to enable Serial Over LAN
and IDE redirection on the client
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Check Allow ping responses to enable the Management Controller to respond to
ping requests when the client Operating System is not running

Check Enable BIOS password bypass for power on and restart commands to
enable clients to boot past any BIOS password during remote power-on or reset
operations

Uncheck Enable support for Intel WS-MAN translator

x
802.1X and Wireless I Audit Settings I Provisioning Schedule ]
General AMT Settings I Provisioning Settings |

Specify settings used to configure Intel AMT-based computers.

AMT user accounts: | =) | |

Account Name I Rights ]
VYPROLAB\Domain ... PT Administration

Default IDE-redirect image
Example: {icontososerveriISO\Diagnose.ISO

I Browse... I

Manageability is on in the following power state:

lAIways on (50-55) L]

IV Enable Web interface
[V Enable serial over LAN and IDE redirection
V' allow ping responses
Enable BIOS password bypass for power on and restart

[V commands {requires that the manufacturer has enabled the BIOS
password bypass option for AMT)

[~ Enable support for Intel WS-MAN translator

Kerberos clock tolerance {minutes): S 33
aK I Cancel I Apply I Help l

Figure 22 - Out of Band Management Properties AMT Settings Tab

Click Apply to save the AMT Settings tab settings

In the Out of Band Management Properties dialog, click the Provisioning
Settings tab

Click the * button to add any non-factory default MEBX user credentials to the
AMT Provisioning and Discovery accounts list. The MEBX credentials added to
this list are used by ConfigMgr to initially authenticate with Management
Controllers during provisioning and network discovery operations. For this lab
use a name of admin and a password of P@sswOrd
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5
Name: |admin
Password: I .........
Confirm d: :
Description: |Strong admin password
Cancel

Figure 23 - AMT Provisioning and Discovery Account Dialog

Out of Band Management Properties 3 x|
802.1X and Wireless I Audit Settings ] Provisioning Schedule |
General | AMT Settings Provisioning Settings

Specify provisioning settings for out of band management controllers.

AMT Provisioning and Discovery Accounts: g | _]'I 5 I

MName | Description I
admin Standard strong password

0K I Cancel | Apply l Help |

Figure 24 - Out of Band Management Properties Provisioning Settings Tab

e Click Apply to save the Provisioning Settings tab settings

¢ In the Out of Band Management Properties dialog, click the Provisioning
Schedule tab

e Set the AMT provisioning schedule to determine the client provision process start
time and recurrence if provisioning is unsuccessful. For this lab select Simple
schedule and set Run every to 1 day
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x
General I AMT Settings | Pravisioning Settings ]
8021 and Wieless | Audit Setiings Pravisioning Schedule

Specify how often AMT-based computers initiate in-band provisioning.

—AMT provisioning schedule
«

ll E IDays ZI

Run every:

" Custom schedule

oK I Cancel I Aoply I Help l

Figure 25 - Out of Band Management Properties Provision Polling Schedule Tab

e Click OK to save the Out of Band Management Properties

¢ Do not close the Configuration Manager console

O Tick this box when you have completed all steps in this procedure

Configure Site Parameters to Use Secure Remote Power Control

e Expand Site Database > Site Management, right-click ISW and click Properties

e At the Site Properties dialog, click the Wake On LAN tab

e Check Enable Wake On LAN for this site and check either Use power on
commands only or Use power on commands if the computers support this

technology; otherwise use wake-up packets depending on the computers and
network infrastructure
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ISW - Intel vPro Lab Properties ] x|

General ‘Wake OnLAN I Ports | Advanced | Site Made | Secuity |

‘Wake On LAN settings configure how this site will send wake-up packets or power on
commands for scheduled activities.

IV Enable Wake On LAN For this site

& ;Llse power on commands if the computers support this technology; otherwise,
iuse wake-up packets

€ Use power on commands only

" Use wake-up packets only

Wake on LAN iission method
Specify how wake-up packets will be sent to computers.

" Subnet-directed broadcasts

' Unicast

Advanced

0K I Cancel | Apply | Help |

Figure 26 - Site Properties Wake On LAN Tab

e Click OK to save the site settings

e Do not close the Configuration Manager console

O Tick this box when you have completed all steps in this procedure

© Copyright 2011 Intel Corporation



33

Configure ConfigMgr for Out of Band Management Console
Operations

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

e Configure Certificate Repository on Out of Band Management Console Host

e Install Telnet Client on Out of Band Management Console Host

Configure Certificate Repository on Out of Band Management
Console Host

IMPORTANT: During redirection operations such as Serial Over LAN or IDE
Redirection, when the Out of Band Management console is attempting to authenticate
certificates from Management Controllers to establish a secure channel, only the Trusted
Root Certification Authority store is searched by the console to build a trusted certificate
chain

Therefore if the certificate authority used to issue certificates to the Management
Controller is not a Root Certificate Authority (i.e. there are intermediate certificates
between the Management Controller certificate and the Root Certificate Authority
certificate), the intermediate certificates from the Management Controller certificate
signing chain must be available in the local machine Trusted Root Certification Authority
store on the workstation hosting the Out of Band Management console otherwise
redirection operations will fail

e On the SCCM server, open the Microsoft Management Console (MMC)

e Add the Certificates Snap-in to MMC and chose to manage certificates for the
local Computer account

e At the Microsoft Management Console, expand Certificates (Local Computer)
> Intermediate Certification Authorities > Certificates

e Locate all internal PKI intermediate certificates from the signing chain for
certificates issued to Management Controllers, select and copy them into the
Certificates (Local Computer) > Trusted Root Certification Authorities >
Certificates folder. For this lab the vProLab Enterprise Issuing CA
intermediate certificate should be selected and copied. This step only needs to be
performed once during setup of the Out of Band Management console host
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e Close the Microsoft Management Console

O Tick this box when you have completed all steps in this procedure

Install Telnet Client on Out of Band Console Host

IMPORTANT: To use Serial Over LAN the telnet client must be installed on the system
hosting the Out of Band Management Console

e Onthe SCCM server, use Control Panel > Programs to add the Telnet client.
This step only needs to be performed once during setup of the Out of Band
Management console host

O Tick this box when you have completed all steps in this procedure
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Provision Intel vPro Client Management Controller using
ConfigMgr Agent

IMPORTANT: Before proceeding with this exercise, ensure the following pre-requisites
have been completed; the Intel vPro client Management Controller should be in a factory
default state or fully un-provisioned using the MEBX

Your instructor will be able to help you complete these steps

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

Configure ConfigMgr for Automatic Management Controller Provisioning
Generate In-Band Provisioning Policy
(Optional) Retrieve ConfigMgr Client Policies

Monitor Provisioning Progress of Client Management Controllers

Configure ConfigMgr for Automatic Management Controller
Provisioning

On the SCCM server, click Start > All Programs > Microsoft System Center >
Configuration Manager 2007 > ConfigMgr Console

Expand Site Database > Computer Management > Collections > All vPro
Systems and right-click the All Un-Provisioned vPro Systems sub-collection.
Click Modify Collection Settings

At the All Un-Provisioned vPro Systems Settings dialog, click the Out of Band

tab and check Enable automatic out of band management controller
provisioning. Click OK
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All Un-Provisioned vPro Systems Settings x|

Maintenance Windows I Collection Variables I Advanced OutofBand I

Out of Band Management Controller Provisioning

Computers capable of being managed out of band in this collection can
be automatically provisioned for out of band access using the
provisioning settings for this site.

¥ Enable automatic out of band management controller provisioning

OK I Cancel | Help |

Figure 27 - Out of Band Collection Settings

e Repeat the above steps for the All Provisioned vPro Systems sub-collection

¢ Do not close the Configuration Manager console

HELPFUL HINT: In a production environment, membership criteria for collections
where automatic Management Controller provisioning is enabled may need to be refined
so that only specific Intel vPro clients are provisioned. For example additional criteria
may need to be added to identify clients located in specific buildings or departments or
are members of specific Active Directory groups to provide additional control over which
clients are provisioned

O Tick this box when you have completed all steps in this procedure

Generate In-Band Provisioning Policy

HELPFUL HINT: ConfigMgr client policies are automatically generated periodically
and do not need to be manually generated. However for lab purposes we have chosen to
manually re-generate policies to accelerate the in-band provisioning process

e Expand Site Database > Computer Management > Collections
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e Select the All vPro Systems collection and update the collection membership for
this collection and all sub-collections to force ConfigMgr to re-generate policies
for collection members and enable the automatic provisioning policy

¢ Do not close the Configuration Manager console

O Tick this box when you have completed all steps in this procedure

(Optional) Retrieve ConfigMgr Client Policies

HELPFUL HINT: ConfigMgr client machine policies are normally retrieved
automatically and applied periodically and do not need to be manually retrieved.
However for lab purposes we have chosen to manually retrieve machine policies to
accelerate the in-band provisioning process

e Logon to the Intel vPro client. For this lab logon with username
Administrator@vprolab.com and password of P@sswO0rd

e Open Control Panel and open Configuration Manager. For clients running
Windows XP, Configuration Manager is located under Administrative Tools, for
clients running Windows Vista or Windows 7, Configuration Manager is located
under System and Maintenance or System and Security

e At the Configuration Manager Properties dialog, click the Actions tab
e Select Machine Policy Retrieval and Evaluation Cycle, and click Initiate
Action to force the client to update policy settings. If the action cannot be

initiated then wait for 1-2 minutes for the ConfigMgr client services to fully
initialize and retry this operation
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i Configuration Manager Properties @@
Updates Configurations = Internet
Genersl | Components | Actions Advanced

‘You can initiate actions to occur on the Configuration Manager components
currently installed on your computer.

Actions:

Branch Distribution Point Maintenance Task
Discovery Data Collection Cycle
File Collection Cycle

| Hardware Inventory Cycle

:
Software Inventory Cycle
Software Metering Usage Report Cycle
Software Updates Deployment Evaluation Cycle
User Policy Retrieval & Evaluation Cycle
Windows Installer Source List Update Cycle

|
Initiate Action

[ oK J[ Cancel J

Figure 28 - Configuration Manager Properties Actions Tab

e Close the Configuration Manager on the client

O Tick this box when you have completed all steps in this procedure

Monitor Provisioning Progress of Client Management Controllers

e Onthe SCCM server, click Start > All Programs > ConfigMgr 2007 Toolkit ->
Trace32

e At the SMS Trace main window, open the log file amtopmgr.log and monitor the
incoming provisioning request and operations. Identify the incoming provisioning
request, the start of the provisioning task, the 1st and 2nd stage provisioning
operations and the end of the provisioning task
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€7 SMS Trace - [C:\Program Files (x86)\Microsoft Configuration Manager\Logs\amtopmar.log] -0l x|
&4 Fle Tools Window Help -18] x|
E=G méan
Log Text | Component | Date/Time | Thread |

AMT Provision Worker: Wait 20 seconds... SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:35 1380 ((&x564) _f_l
>>3333>>33>>>>>>Provision task begin<<<<<<<<<<<<<<< SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:35 2196 ((x834)
Provision target is indicated with SMS resource id. (Machineld = 27 DELLE6410.vprodemo.com) SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:35 2196 ((x834)

Start to send a basic machine property creation request to FDM. (Machineld = 27) SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:35 2196 ((x834)

CStateMsgReporter::DeliverMessages - Queued message: TT=1201 TIDT=0 TID="Fill Machine | SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:35 2196 ((x834)
CStateMsgReporter::DeliverMessages - Created state message file: C:\Program Files (x86)\Micrc SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:35 2136 ((x834)

Waming: Cumrently we dont support mutual auth. Change to TLS server auth mode. SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:35 2196 ((x834)

The provision mode for device DELLE6410.vprodemo.comis 1. SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:35 2196 ((x8394)
Check target machine (version 6.1.0)is a SCCM support version. (TRUE) SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:35 2196 ((x854)

The IP addresses of the host DELLE6410.vprodemo.com are 132.168.0.100. SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:35 2136 ((x854)
Attempting to establish connection with target device using SOAP. SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:35 2196 ((x8394)
Found matched certificate hash in cument memory of provisioning certificate SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:35 2196 ((x834)
Create provisionHelper with (Hash: 5FF3B807760B1077D72B261920145B5578F 33A8F) SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:35 2196 (0x894)

Set credential on provisionHelper... SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:35 2136 ((x834)

Try to use provisioning account to connect target machine DELLE6410.vprodemo.com... SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:35 2196 ((x834) __i
Succeed to connect target machine DELLE6410.vprodemo.com and core version with 6.1.0 usi SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:36 2196 ((x8394)
Generallnfo GetProvisioningState finished with HResult = 0x0, status = (0, clientErmor = 0. SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:37 2196 ((x854)

Get device provisioning state is In Provisioning SMS_AMT_OPERATION_MANAGE 08/02/2011 10:53:37 2196 ((x834) _:_I
Date/Time: 25/02/2011 16:52:28 Component: SMS_AMT_OPERATION_MANAGER

Thread: 696 (0x288) Source:

AMT WOL Worker: Wait 3500 seconds... =

|Elapsed time is 4965h 30m 14s 222ms (17890214.222 seconds)

N\

Figure 29 - Trace32 Monitoring of Provisioning Task Operations

At the ConfigMgr console, Expand Site Database > Computer Management >
Collections, select the All vPro Systems collection and update the collection
membership for this collection and all sub-collections. If provisioning was
completed successfully, the All vPro Systems and All Provisioned vPro
Systems collections should contain the provisioned Intel vPro client and the All
Un-Provisioned vPro Systems collection should be empty. If the All
Provisioned vPro Systems collection is empty and the All Un-Provisioned vPro
Systems collection still contains the Intel vPro client provisioning was
unsuccessful. Use Trace32 to inspect the provisioning operations and correct any
errors

Verify that a Computer object was successfully created in the OU specified for
Management Controller objects and the object account is enabled. Verify that the
issuing certificate authority issued a certificate to the Management Controller

O Tick this box when you have completed all steps in this procedure
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Simple Intel vPro Client Management using AMT WebUI

HELPFUL HINT: After provisioning, the AMT WebUI built into the Management
Controller is available on all Intel vPro Technology platforms and can be used to perform
simple one-on-one client troubleshooting using hardware inventory retrieval, BIOS event
logs and remote client power control. The AMT WebUI can be configured so that it
available regardless of client power state or it can be completely disabled if not required

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

e Connect to AMT WebUI

e Use AMT WebUI To Perform Simple Client Management

Connect to AMT WebUI

IMPORTANT: Microsoft KB908209 and the associated registry entry must be installed
on systems hosting Internet Explorer 6, 7 or 8 before logging into the AMT WebUI using
Kerberos authentication

e On the domain controller or SCCM server, open Internet Explorer and enter a
URL of https://vproclient.vprolab.com:16993 to connect to the AMT WebUI. If
the browser is unable to connect, close the browser and use the command
ipconfig /flushdns to flush any residual DNS information. Re-open the browser
and retry connecting to the AMT WebUI

e Atthe AMT WebUI, logon with username VPROLAB\Administrator and
password P@sswOrd
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; Intel® Active Management Technology - Microsoft Internet Explorer - 5[29
File Edit View Favorites Tools Help ‘ .'f
QBack » &) - [¥] &) & | ) Search ¢ Favorites % | Q- B
Address @ https:{}vproclient.vprolab.com: 16993findex.htm? ;1 Go | Links >
Intel®Active Management Technology intel'
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Figure 30 - VPROLAB\Administrator User WebUI Console

Use AMT WebUI to Perform Simple Client Management

e Use the left-hand navigation bar and explore the simple client management
options available. These options include simple hardware inventory, Management
Controller event log, client power control, client management controller power
policies and account modification

O Tick this box when you have completed all steps in this procedure
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On-Demand Remote Power Control of Intel vPro Clients

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

e On-Demand Remote Power Control from ConfigMgr Console
¢ Invoke Out of Band Management Console

e On-Demand Remote Power Control from Out of Band Console

On-Demand Remote Power Control from ConfigMgr Console

e On the SCCM server, click Start > All Programs > Microsoft System Center >
Configuration Manager 2007 > ConfigMgr Console

e Expand Site Database > Computer Management > Collections

e Select the All Systems collection

¢ Inthe All Systems pane, right-click the client to be remotely controlled. If more
than one client will be remotely controlled hold down the Ctrl key and click each

of the other clients to perform a multiple client selection. Right-click the selected
client and click Out of Band Management > Power Control
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Figure 31 - Launch Client Power Control

e At the Power Control dialog box, select Power Off in the Select power control
action to perform list and click OK. At the confirm power off dialog click OK.
After a few seconds client systems will power off

Power Control for YPROCLIENT x|

Select power control:

OK |

Cancel |

Figure 32 - Client Power Control Dialog

e Inthe All Systems pane, right-click the client to be remotely controlled. If more
than one client will be remotely controlled hold down the Ctrl key and click each
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of the other clients to perform a multiple client selection. Right-click the selected
client and click Out of Band Management > Power Control

e At the Power Control dialog box, select Power On in the Select power control
action to perform list and click OK. After a few seconds client systems will
power on

HELPFUL HINT: If client systems will be managed Out of Band, client Management
Controllers must be configured to be active when the platform is in sleep or powered off
states using the Management Controller power policies. By default, ConfigMgr
configures Management Controllers to be active in all client power states

O Tick this box when you have completed all steps in this procedure

Invoke Out of Band Management Console

e Expand Site Database > Computer Management > Collections
e Select the All Systems collection

e In the All Systems pane, right-click the client to be managed and click Out of
Band Management > Out of Band Management Console
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Figure 33 - Launch Out of Band Management Console

O Tick this box when you have completed all steps in this procedure

On-Demand Remote Power Control from Out of Band Console

e At the Out of Band Management Console, wait for the client system status shown
at the bottom left hand corner of the console to change from Disconnected to
Connecting to Busy to Connected

e At the Out of Band Management Console , select System Status to view the
current client status
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E Out of Band Management Console

File
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14:18:38

| 5 System: Connected

| IDE-Redirect: Inactive

| Serial connection: Inactive | wPROCLIENT | 192.168.11.32

Figure 34 - Out of

Band Console Showing System Status

At the Out of Band Management Console, select Power Control to view the

power control options. This may take 10-20 seconds to complete. If necessary use
the ** Refresh button

E Out of Band Management Console §

File
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Connection  Tools

Help

@ System Status

E 3 System Information
ﬂ Power Control
@ System Event Log
M%) DE-Redrect Log
@ System Audit Log

- Serial Connection

Power control allows you to

Power [n

Power Off I
BRestart Computer l

™| Bypass BIOS password

™ Lock remote keyboard

view and update the power state of the computer and set available boot options.

Boot option:

Intel(r) AMT: Force Hard-drive Boot
Intel(r) AMT: Force CD/DVD Boot
Intel(r] AMT: Force PXE Boot

¢ Boot from local drive

€ Boot from file
Wil Data Storage |DE tedirection file path
Example: \ycontoso_serverisharehdiagnostic.iso
| Browse
L;L; System: Connected | IDE-Redirect: Inactive [ Serial connection: Inactive l YPROCLIENT | 192.168.11.32

Figure 35 - Out of Band Console Showing Power Control with NormalBoot Option

Select NormalBoot in the Boot Option: list and click Power Off to power down

the client. At the Confirmation dialog click Yes. After a few seconds the client
system will power off
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e At the Out of Band Management Console, use the + Refresh button to refresh
the power options. Select NormalBoot in the Boot Option: list and click Power
On to power up the client. At the Confirmation dialog click Yes. After a few
seconds the client system will power on

e Close the Out of Band Management Console

O Tick this box when you have completed all steps in this procedure
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Retrieve Real-Time Intel vPro Client Hardware Inventory
Information

HELPFUL HINT: Hardware inventory information is available from Intel vPro clients
regardless of their power state. Information is obtained in ‘real-time’ and provides an IT
helpdesk technician with accurate hardware information for troubleshooting or ordering
replacement parts

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

¢ Invoke Out of Band Management Console

e Retrieve Client Hardware Information

Invoke Out of Band Management Console

e On the SCCM server, click Start > All Programs > Microsoft System Center >
Configuration Manager 2007 > ConfigMgr Console

e Expand Site Database > Computer Management > Collections
e Select the All Systems collection

¢ Inthe All Systems pane, right-click the client to be managed and click Out of
Band Management > Out of Band Management Console
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Figure 36 - Launch Out of Band Management Console

O Tick this box when you have completed all steps in this procedure

Retrieve Client Hardware Information

|
| 8% 9@ 1411

e At the Out of Band Management Console, wait for the client system status shown
at the bottom left hand corner of the console to change from Disconnected to
Connecting to Busy to Connected

e At the Out of Band Management Console, select System Information to view the
client system hardware inventory. This may take 10-20 seconds to complete. If
necessary use the ** Refresh button
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Figure 37 - Out of Band Console Showing System Information

e Select some of the hardware inventory items and examine the information
available

e Use the Power Control capabilities of the Out of Band Management Console to
power off the client and verify that hardware inventory can still be retrieved when

the client is off

e Close the Out of Band Management Console

O Tick this box when you have completed all steps in this procedure
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Remote BIOS Setup Access with Intel vPro Clients Using Serial
over LAN

HELPFUL HINT: Serial over LAN (SOL) can be used to view BIOS POST messages
and interact with BIOS Setup to help with remote PC troubleshooting

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

¢ Invoke Out of Band Management Console

e Invoke Client BIOS Setup

Invoke Out of Band Management Console

e On the SCCM server, click Start > All Programs > Microsoft System Center >
Configuration Manager 2007 > ConfigMgr Console

e Expand Site Database > Computer Management > Collections
e Select the All Systems collection

¢ Inthe All Systems pane, right-click the client to be managed and click Out of
Band Management > Out of Band Management Console
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Figure 38 - Launch Out of Band Management Console

O Tick this box when you have completed all steps in this procedure

Invoke Client BIOS Setup

e At the Out of Band Management Console, wait for the client system status shown
at the bottom left hand corner of the console to change from Disconnected to
Connecting to Busy to Connected

e At the Out of Band Management Console, select Open Serial-over-LAN

Connection from the Tools menu to make the serial connection active. The Serial
connection status will change from Inactive to Active
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Figure 39 - Out of Band Console Opening Serial-over-LAN Connection

e At the Out of Band Management Console, select Power Control to view the
power control options. This may take 10-20 seconds to complete. If necessary use
the * Refresh button. Select BIOS in the Boot Option: list and click Power On
or Restart System. At the Confirmation dialog click Yes
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Power control allows you to view and update the power state of the computer and set available boot options.
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Figure 40 - Out of Band Console Showing Power Control with BIOS Option
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e At the Out of Band Management Console, select Serial Connection to view
BI1OS POST and BIOS Setup messages on the Serial over LAN console. If
necessary click the console pane

E‘Dut of Band Management Console § = =] o
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| & System: Connected | IDE-Redirect: Inactive Serial connection: Active \ VYPROCLIENT \ 192.168.11.32

Figure 41 - Out of Band Console Showing Serial Connection with BIOS Setup

e Click in the console pane to enter keystrokes at the console and use the console to
view and explore BIOS options. Once you have finished exploring the BIOS
options, exit BIOS Setup without saving any changes

e Close the Out of Band Management Console. At the Confirm Disconnect dialog
click Restart to reboot the client

O Tick this box when you have completed all steps in this procedure
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Remote Boot Intel vPro Clients with Remediation Software Using
IDE Redirection

HELPFUL HINT: IDE Redirection (IDER) can be used to securely boot Intel vPro
clients from ISO images located on the ConfigMgr Server or other network drives. ISO
images can contain diagnostic software to perform remote PC troubleshooting or
Operating System installation software

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

¢ Invoke Out of Band Management Console

e Boot Client Using IDE Redirection

Invoke Out of Band Management Console

e On the SCCM server, click Start > All Programs > Microsoft System Center >
Configuration Manager 2007 > ConfigMgr Console

e Expand Site Database > Computer Management > Collections
e Select the All Systems collection

¢ Inthe All Systems pane, right-click the client to be managed and click Out of
Band Management > Out of Band Management Console
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Figure 42 - Launch Out of Band Management Console

O Tick this box when you have completed all steps in this procedure

Boot Client Using IDE Redirection

| 8% 9@ 1411

At the Out of Band Management Console, wait for the client system status shown
at the bottom left hand corner of the console to change from Disconnected to
Connecting to Busy to Connected

At the Out of Band Management Console, select Open Serial-over-LAN
Connection from the Tools menu to make the serial connection active. The Serial
connection status will change from Inactive to Active

At the Out of Band Management Console, select Power Control to view the
power control options. This may take 10-20 seconds to complete. If necessary use
the ** Refresh button. Select IDER in the Boot Option: list, check the Boot

from file option and use the Browse button to select a boot image. For this lab
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use C:\IDER\dos_gold.iso as the boot image. Click Power On or Restart

System. At the Confirmation dialog click Yes
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Figure 43 - Out of Band Console Showing Power Control with IDER Option

e At the Out of Band Management Console, select Serial Connection to view
BI1OS POST messages and the operating system booting from the boot image. If

necessary click the console pane
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Figure 44 - Out of Band Console Showing Serial Connection with Operating System
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e Click in the console pane to enter keystrokes at the console and use the console to
enter operating system commands

e Close the Out of Band Management Console. At the Confirm Disconnect dialog

click Restart to reboot the client

O Tick this box when you have completed all steps in this procedure

© Copyright 2011 Intel Corporation



59

Enable Hardware KVM on Intel vPro Clients

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

e Enable Hardware KVM Using HTA

e Enable Hardware KVM Using Intel SCS 7.X Delta Provisioning

Enable Hardware KVM Using HTA

HELPFUL HINT: The HTML application (HTA) for enabling hardware KVVM is suited
for enabling hardware K\VM on-demand on single clients. The logged on user must have
access to the PT_Administration realm of the Management Controller in order to enable

hardware KVM

e Onthe SCCM server, open the HTML application (HTA) for enabling hardware
KVM. For this lab, the application is available using the Enable Hardware
KVM HTA shortcut on the desktop

e Enter the FQDN for the remote Intel vPro client and a New RFB Password

consisting of a combination of uppercase and lowercase characters, numbers and
special characters. For this lab use the password P@sswOrd
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£ 1 Remote Control Conpguration with Kerberos andTis =l
- - .A—I
KVM Remote Control Configuration
Step 1
Click the button below to configure WinRM. This must be done before remotely configuring Intel AMT below. Only needs to
be run once per management console
Configure WinRM
Step 2
Enter the information below and click Enable to remotely configure Intel AMT for KVIM Remote Control on the specified
managed client. To reset to the default diabled state. click Disable
FQDN |VPROCLIENT.vprolab.com FQDN of your Managed Client
New RFB P@sswlrd New Password to be used with KVM Remote Control Sessions. Note
Password Must be exactly 8 characters and be a strong password
Enable | Disable
Step 3 (optional)
As a security feature. when you connect to a managed client. the client's user must grant KVIM Remote Control access to
his or her client system. This is also known as Opt-In Consent. To bypass client user consent, click Opt-In Off. To reset to
the default of requiring client user consent. click Opt-In On
Note: Intel AMT firmware can be configured in Inte! MEBX to not allow the opt-in setting to be changed. See section 3 of the
accompanying use case reference design
Opt-in On Opt-In Off
2]

Figure 45 — HTML Application for Enabling Hardware KVM
e Click Enable to enable hardware KVVM on the remote Intel vPro client

e The output of the hardware KVVM enabling operation is shown in the Output
section at the bottom of the HTA window. Verify that the return code was 0
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[N KVM Remote Control Configuration with Kerberos and TLS 3 =10l x|
B S ——
Password Must be exactly 8 characters and be a strong password Al

Disable

Step 3 (optional)

As a security feature, when you connect to a managed client. the client's user must grant KVIM Remote Control access to
his or her client system. This is also known as Opt-In Consent. To bypass client user consent. click Opt-In Off To reset to
the default of requiring client user consent, click Opt-In On

Note:
accomp

firmware can be configured in Intel MEBX to not allow the opt-in setting to be changed. See section 3 of the
ng use case reference design

Opt-in On Opt-In Off

Output

=gIPS_KVMRedirectionSettingData xmllang="" xmins:g="http:/‘intel. com/whem/wscim/'l /ips-
schema'l/IPS_KVMRedirectionSettingData">
<gDefaultScreen>0</gDefaultScreen=

<gElementName>Intel(r) KVM Redirection Settings</gElementName>
<gEnabledByMEBx>true</gEnabledByMEBx>

<gInstancelD=>Intel(r) KVM Redirection Settings</g:InstancelD=
<gIs5900PortEnabled>true</gIs5900PortEnabled>
<g:OptInPolicy>true</g:OptInPolicy>
<g:OptInPolicyTimeout>300</g:OptInPolicy Timeout>
<gRFBPassword></gRFBPassword>
<g:SessionTimeout>3</g:SessionTimeout>
</gIPS_KVMRedirectionSettingData>

<gRequestStateChange OUTPUT xmllang="" xmins:g="http://schemas.dmtf org/ wbem'wscim'l/cim-
schema’2/CIM_KVMRedirectionSAP">

<gReturnValue>0</gReturnValue>

</gRequestStateChange_ OUTPUT>

v

Figure 46 - Output from HTML Application for Enabling Hardware KVM

e (Optionally) Click Opt-in on or Opt-in off to remotely enable or disable the user
consent option for opening a hardware KVVM session. For this lab click Opt-in on
so that user consent is required

e Close the HTML application

Enable Hardware KVM Using Intel SCS 7.X Delta Provisioning

HELPFUL HINT: SCS 7.X delta provisioning is suited for enabling hardware KVM
automatically on multiple clients

e Create domain account for RCS Service User

e Create domain security group for RCS Service Users and add RCS Service User
to this group

e On SCS server, create local RCS Admins security group
e On SCS server, install the Wizard and Service components of SCS 7.X. Select

the RCS Service User as the service user
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On SCS server, configure RCS Admins group with DCOM and WMI permissions
for RCS

At ConfigMgr console, add RCS Service Users domain security group into AMT
ACL with PT_Administration realm access

At ConfigMgr console, update Management Controller settings to apply updated
AMT ACL

On SCS server, use ACU Wizard to create SCS Delta Provisioning Profile on
SCS server that includes Hardware KVM

At ConfigMgr console, create SCS Delta Provisioning Package Containing ACU
Configurator and batch file to invoke delta provisioning operation

At ConfigMgr console, advertise SCS Delta Provisioning Package to provisioned
Intel vPro clients

Monitor package completion

O Tick this box when you have completed all steps in this procedure
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Hardware KVM with RealVNC VNC Viewer Plus and Intel vPro
Clients

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

e Connect to Intel vPro Client Using VNC Viewer Plus
e Remote Client BIOS and Boot Operations with Hardware KVM

e Remote Client Diagnostics with Hardware KVM

Connect to Intel vPro Client Using VNC Viewer Plus

e Onthe SCCM server, open VNC Viewer Plus. For this lab, the viewer is available
as a shortcut on the desktop

e Atthe VNC Viewer Plus New Connections dialog, enter the Intel vPro client
FQDN for the AMT Server, select Intel AMT KVM as the Connection Mode
and TLS as the Encryption option. Click Connect to connect to the client

VNC Viewer Plus: New Connection X|
VNC® Viewer Plus for Windows BEAL
See http: /fwww.realvnc.com fOY' more lnfUrY“athﬂ on
VNC. C
d| AMT server: ] VPROCLIENT} vprolab.com _v_]
F
"’ Encryption: !TLS _'J
Connection Mode: lIntei@ AMT KVM _v_|
About... | Options... | Connect I Close |

Figure 47 - VNC Viewer Plus New Connection Dialog

o If the Intel vPro client is powered down the viewer screen will remain black until
the client is remotely powered on using the buttons on the viewer toolbar. If the
end user privacy opt-in policy setting for hardware K\VM requires a user consent
code to be entered, the viewer will prompt for the consent code before a graphical
session can be established. The consent code will be displayed as a sprite on the
Intel vPro client screen. Enter the 6-digit consent code to establish the graphical
session
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Figure 48 - VNC Viewer Plus Consent Code Dialog

Remote Client BIOS and Boot Operations with Hardware KVM

e Connect to the Intel vPro client with VNC Viewer Plus

e From the VNC Viewer Plus toolbar open the Power dialog

e Click Power On or Reset and select Boot to BIOS from the drop down options
e After selecting Boot to BIOS, click Power On or Reset

o If the full BIOS Setup screen is not displayed, use the Close Connection option

from the toolbar to disconnect and re-connect to refresh the screen using the
correct resolution

Remote Client Diagnostics with Hardware KVM

e Connect to the Intel vPro client with VNC Viewer Plus
e From the VNC Viewer Plus toolbar open the Mount Disk Images dialog

e Click Browse... to select an ISO image and click Mount
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e From the VNC Viewer Plus toolbar open the Power dialog

e Click Power On or Reset and select Boot to CD/DVD from the drop down
options

o After selecting Boot to CD/DVD, click Power On or Reset to initiate a client
boot operation using the ISO image

e If the full BIOS POST and ISO boot screen is not displayed, use the Close
Connection option from the VNC Viewer Plus toolbar to disconnect and select

the option to re-connect when prompted to maintain the mounted ISO image and
refresh the screen using the correct resolution

O Tick this box when you have completed all steps in this procedure
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Hardware KVM with Microsoft Service Manager and Intel vPro
Clients

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

e Connect to Intel vPro Client Using Service Manager
[}

Remote Client BIOS and Boot Operations with Hardware KVM

e Remote Client Diagnostics with Hardware KVM

Connect to Intel vPro Client Using Service Manager

On the SCCM server, click Start > All Programs > Microsoft System Center >
Service Manager 2010 > Service Manager Console

In the System Center console, expand Configuration Items > Computers > All
Windows Computers

'@ System Center Service Manager Console

File View Go Tools Tasks Help

-I-\pt‘ ion Items b C jon Items > C

Configuration Items <

All Windows Computers 4
4 [ configuration Items Ll P EditCriteria v | [7] | @
4 * Business Services Principal Name NetBIOS Domain Site Operating System Manufacturer] DELLE6410.vpr0Iab.com A
CONSOLE.vprolab.c. VPROLAB Windows 7 Enterprise
4 & Computers Create Related Change Request
ALV o SCCM.vprolab.com VPROLAB Windows Server 20.
t indows Computers e
= o DELLE6410.vprolab.... VPROLAB Windows 7 Professi... Create Related Incident
the Computers with Active Change Reque: B 1y, yprofab,com VPROLAB 1sw Windows Server 20... % Delete
& Computers with Active Incidents ? Edit
» (5 Printers Z
: Intel vPro KVM Remote Control
Software
2 Intel vPro Power Off
» |« Software Updates
3{ Users Intel vPro Power On
Intel vPro Power Reset
Remove ltems
Restore Items
=2 Search for Knowledge Articles
All Windows Computers ~
(y Refresh
Computers -
Create Computer
,,,,,,,,, DELLE6410.vprolab.com v U [5] Creste Foider
[7]/! Administration . 4 Create Vi
i Object N [ reate View
= . 3
= Library Configuration Items ~
— Display Name: ’ Create Fold
- = | Create Folder
] =]
Work Items DELLEG410.vprolab.com
gc!'"ﬁﬁ‘"‘,ﬁ"“ Items
+| Configuration Item A
Connected to SCCM
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Figure 49 - System Center Console All Computers

In the All Windows Computers pane, select the client to be managed and click
Intel vPro KVM Remote Control from the Tasks pane to connect to the client
using the KVMView application

8 vview [ -lgix|

File  Connection Tools Help

Initializing Viewer...
Using TLS security

Connecting to: DELLE6410.vprolab.com
Using Kerberos authentication
Connecting to: DELLE6410.vprolab.com
Using Proxy 127.0.0.1:49594
Connection Succeeded

Figure 50 - KVM View Connection Dialog

If the Intel vPro client is powered down the viewer screen will remain black until
the client is remotely powered on using the buttons on the viewer toolbar. If the
end user privacy opt-in policy setting for hardware KVVM requires a user consent
code to be entered, the viewer will prompt for the consent code before a graphical
session can be established. The consent code will be displayed as a sprite on the

Intel vPro client screen. Enter the 6-digit consent code to establish the graphical
session
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[ Connected to: DELLE6410.vprolab.com I I [=[ S

File  Connecton Tools Help

1024x768 00:00:07

Figure 51 - KVM View Consent Code Dialog

Remote Client BIOS and Boot Operations with Hardware KVM

e Connect to the Intel vPro client with KVVMView

e From the KVMView toolbar select Power Control > Power Up or Power
Control > Power Reset

e When the client displays BIOS POST messages use the client specific function
key to enter BIOS Setup. This varies from one client to another but is usually F1,
F2, F10 or DELETE

e If the full BIOS Setup screen is not displayed, use the Close Connection option

from the toolbar to disconnect and re-connect to refresh the screen using the
correct resolution

Remote Client Diagnostics with Hardware KVM

e Connect to the Intel vPro client with KVVMView

e From the KVMView toolbar select Power Control > Power Up or Power
Control > Power Reset
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e From the KVMView toolbar select Power Control > Boot with IDER to open
the Media Redirection dialog

e Click Browse... to select an ISO image and click Connect to initiate a client boot
operation using the 1ISO image

e If the full BIOS POST and I1SO boot screen is not displayed, use Connection >
Stop from the KVMView toolbar to disconnect and Connection > Start to re-

connect whilst maintaining the mounted ISO image and refreshing the screen
using the correct resolution

O Tick this box when you have completed all steps in this procedure
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Scheduled Software Deployment Using Intel vPro Remote Power
Control

HELPFUL HINT: ConfigMgr advertisements used in conjunction with Intel vPro
platform secure power control capability can be used to (1) avoid leaving PC’s powered
on to receive software updates resulting in decreased power consumption (2) wake clients
that are powered off to receive critical software updates thus decreasing the time to
achieve critical update penetration resulting in a more secure business environment (3)
deploy non-critical software updates outside normal business hours to reduce the impact
on employee productivity (4) automatically power up PC’s before the start of the business
day so PC’s are ready for immediate use by employees to improve employee productivity

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

e Shutdown Intel vPro Client

o Create Software Package or Task Sequence

e Add Client to Software Package Deployment Collection
e Adbvertise Software Package or Task Sequence

e Observe Client Behaviour

e Review Results from Advertised Software Package

Shutdown Intel vPro Client

e Logon to the Intel vPro client. For this lab logon with username
Administrator@vprolab.com and password of P@sswOrd

o Delete the directory %SystemDrive%”\Virus Patterns” if it exists. This
directory will be re-created when the advertised software package is executed on
the client

e Shutdown the Intel vPro client so it can be woken up using an ConfigMgr
Advertisement

[ Tick this box when you have completed all steps in this procedure
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Create Software Package or Task Sequence

HELPFUL HINT: There are no special requirements when creating ConfigMgr
packages or task sequences for use with Intel vPro clients. The virtual machine images
include pre-configured software packages for use with this exercise

Refer to ConfigMgr documentation for further details on creating ConfigMgr packages
and task sequences

e Onthe SCCM server, click Start > All Programs > Microsoft System Center >
Configuration Manager 2007 > ConfigMgr Console

e Expand System Center Configuration Manager > Site Database > Computer
Management > Software Distribution > Packages to see a list of pre-configured
packages used in this lab

O Tick this box when you have completed all steps in this procedure

Add Client to Operating System Deployment Collection

e Expand System Center Configuration Manager > Site Database > Computer
Management > Collections

o Select the Package Deployment collection, right-click the collection and click
Properties
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figuration Manager Console i = [m] 3]

File  Action YView Window Help |—|—|' 81|
le = |2
50 System Center Configuration = | [[E0 eIl L Actions
B-bg@ SteDatabase (ISW-SC¢l [T e . -
g Collections -
C@ Site Management Look far: | j in |AII Columns _'J Eind How | Clear |
=] Lg Computer Managemer ? New Collection
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4 i Export Objects
&# Al Active Dire Name | Collection Variables | Maintenance Windows u
&P All Desktops a &P all Active Directory Security Groups No No QQ Update Collection Me...
& Al Systems &# All Desktops and Servers No No % Import Objects
g All Unknown C ; All Systems Mo No =) b
& All User Group ; ] Distribute »
All Unknown Computers Mo No
g 2:: S\Isi:;sows 2 ; All User Groups No No [ Transfer Site Settings
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> i All Windows Mobile Pocket PC 2003 Devices No No
& Al Windows ¥ i it g @ Give Feedback
? All Windows M All Windows Mobile Pocket PC 5.0 Devices Mo No
@ Al windows 5 .; All Windows Mobile Smartphone 2003 Devices Mo No View »
«j All Windows 5 ; All Windows Mabile Smartphone 5.0 Devices No No e ——
~_§ All Windows 4 § All Windows Server 2003 Systems Mo Mo !
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2"&‘”?"3 Metering @ Update Collection Me...
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Desired Configura L} Export Objects
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E"* Mobile Device Mar
165, Network Access P_ X Delete Special
G- System Status 7 Distribute >
[#-[3 Security Rights
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[ | |

Figure 52 - Package Deployment Collection

e At the Package Deployment Properties dialog, click the Membership Rules tab
and click the Computer icon to launch the Create Direct Membership Rule Wizard
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< Brevious: Mext > | st

Figure 53 - Direct Collection Membership Rule Wizard

e Use the wizard to add the Intel vPro client to the membership rules for the
Package Deployment collection
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Windows 7 Deployment Properties g 5}

General Membership Rules lAdverlisements] Security |

Collection membership rules determine which resources are included in
the collection when it is updated. A membership rule can be a direct
assignment or a query.

Membership rules: %I | JI JI XI

vproclient

p

v Update this collection on a schedule
Occurs every 1 day(s) effective 31/08/2009 12:15

Schedule...

0K I Cancel | Apply | Help |

Figure 54 - Direct Collection Membership Rule Dialog

e Select the Package Deployment collection, right-click the collection and click
Update Collection Membership. Refresh the collection until the hourglass
disappears from the collection and the Intel vPro client is shown as a member of
the collection

O Tick this box when you have completed all steps in this procedure

Advertise Software Package or Task Sequence

e At the Configuration Manager console, expand System Center Configuration
Manager > Site Database > Computer Management > Software Distribution

¢ Right-click Advertisements and click New > Advertisement to launch the New
Advertisement Wizard

e On the General page, enter Virus Pattern Update Advertisement into the Name
field. Use the Browse... button to select Virus Pattern Update Package for the
Package field. Use the dropdown menu to select Virus Pattern Update
Program for the Program field. Use the Browse... button to select Package
Deployment for the Collection field. Click Next
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New Advertisement Wizard ) x|
g;g General
Schedule ‘ Name: irus Pattern Update
Distribution Points
Interaction Comment: 3
Security
Summary
Progress Ll
Confirmation
Package: lVirus Pattern Update Package Browse. .. I
Program: IVirus Pattern Update Program L]
Collection: IAMT Systems i Browse...

V' Include members of subcollections

< Previous MNext = | Fimish I Cancel

Figure 55 - New Advertisement Wizard General Page

e On the Schedule page, click the * button to add mandatory assignments. Select an
appropriate schedule for the mandatory assignment. For this lab, check Assign
immediately after this event and select As soon as possible from the dropdown
box. Click OK to close the Assignment Schedule dialog

Assignment Schedule i x|

" Assign to the following schedule:

Occurs on 217102008 10:36

Schedule, ., |

IAs soon as possible ;]

(% {assign immediately after this event: :

0K I Cancel I Help I

Figure 56 - Advertisement Assignment Schedule Dialog
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e On the Schedule page, check Enable Wake On LAN, Ignore maintenance
windows when running program and Allow system restart outside
maintenance windows. Click Next

New Advertisement Wizard

gj Schedule

General Specify when the program will be advertised to members of the target collection, You can also create

_ an assignment to make the program mandatory.

Distribution Points

Advertisement start time:

Interaction
et |02/09/2009 =] J1s:37 = I urc
ecurity =
™ advertisement expires:
Summary =
03/03/2010 v |15:37 =
Progress I — —JI = =i lure
Confirmation Mandatory assignments: 2 I —@r | xl

As soon as possible

IV Enable Wake On LAN

v Ignare maintenance windows when running program

[V liow system restart outside maintenance windows

Priority: IMedium

Lef Lol

Program rerun behavior: IRerun if Failed previous attempt

< Previous " Next = I FEinishi I Cancel

Figure 57 - New Advertisement Wizard Schedule Page

e On the Distribution Points page, click Next

e On the Interaction page, click Next

e On the Security page, click Next

e On the Summary page, review the settings and click Next

¢ On the Confirmation page, click Close

O Tick this box when you have completed all steps in this procedure
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Observe Client Behaviour

e ConfigMgr will wake-up the Intel vPro client according to the schedule assigned
to the advertisement

e The ConfigMgr agent will retrieve and process the advertisement. This can take 5
to 10-minutes from the time the client boots to the Operating System

O Tick this box when you have completed all steps in this procedure

Review Results from Advertised Software Package

e For this lab, the Intel vPro client will retrieve the advertised software package and
execute the package program. The package program simulates a software update
process, writes an audit log file to the client local disk and performs a client
shutdown. For this lab, it may take 10 minutes for the client to retrieve the
advertisement, execute the package program and shutdown the client

e After the Intel vPro client has been shutdown by the advertised package, power up
the client

e Logon to the Intel vPro client. For this lab logon with username
Administrator@vprolab.com and password of P@sswO0rd

e Examine the contents of the directory %SystemDrive%\Virus Patterns and
locate the log file written by the software package that was advertised and
executed. Verify that the log file contains the time and date when the advertised
package was executed

O Tick this box when you have completed all steps in this procedure
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On Demand Operating System Deployment using Intel vPro
Forced PXE Boot

HELPFUL HINT: Using Intel vPro remote forced PXE boot to deploy an Operating
System works well when it is necessary to deploy an Operating System “on-demand” to a
single client

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

e Create Operating System Deployment Task Sequence

e Add Client to Operating System Deployment Collection

e Advertise Task Sequence To Operating System Deployment Collection
¢ Invoke Out of Band Management Console

e Remotely Boot Client Using PXE

e Observe Operating System Installation

Create Operating System Deployment Task Sequence

HELPFUL HINT: There are no special requirements when creating ConfigMgr
packages or task sequences for use with Intel vPro clients. The virtual machine images
include pre-configured task sequences for use with this exercise

Refer to ConfigMgr documentation for further details on creating ConfigMgr packages
and task sequences

e Onthe SCCM server, click Start > All Programs > Microsoft System Center >
Configuration Manager 2007 > ConfigMgr Console

e At the Configuration Manager console, expand System Center Configuration
Manager > Site Database > Computer Management > Operating System
Deployment > Task Sequences to see a list of pre-configured task sequences
used in this lab
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Figure 58 - Pre-Configured Task Sequences

and click Edit to launch the Task Sequence Editor
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Install Windows 7 Enterprise (x86) Task Sequence Editor . =10 x|
add ~ | Remove (,3 Properties [ Optians |
B8} Install Operating System Type: l(;mup
2 Restart in Windows PE
& Partition Disk 0 Mame: lInstaII Operating System
2 Apply Ol?erating SysFem Description: Actions to run in Windows PE to install and configure
& Apply Windows Settings = the image
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2 Apply Device Drivers ) ) ) )
|4 Setup Operating System Mo settings are required for this action.
2 Setup Windows and Confighgr
|4 Install Software
@ Install Software
@ Install Software

OK I Cancel | Apply | Help

Figure 59 - Windows 7 Installation Task Sequence

e Use the Task Sequence Editor to inspect the example task sequence but do not
make any changes for this lab. Click Cancel to close the editor without saving any
changes

O Tick this box when you have completed all steps in this procedure

Add Client to Operating System Deployment Collection

e Expand System Center Configuration Manager > Site Database > Computer
Management > Collections

e Select the Windows 7 Deployment collection, right-click the collection and click
Properties
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Figure 60 - Windows 7 Deployment Collection
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At the Windows 7 Deployment Properties dialog, click the Membership Rules
tab and click the Computer icon to launch the Create Direct Membership Rule
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Create Direct Membership Rule Wizard

< Brevious: Mext > | st

Figure 61 - Direct Collection Membership Rule Wizard

e Use the wizard to add the Intel vPro client to the membership rules for the
Windows 7 Deployment collection
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O Tick this box when you have completed all steps in this procedure

Advertise Task Sequence to Operating System Deployment
Collection

Windows 7 Deployment Properties g

General Membership Rules lAdverlisements] Security |

Collection membership rules determine which resources are included in
the collection when it is updated. A membership rule can be a direct
assignment or a query.

Membership rules: %I | JI JI XI

vproclient

Direct: Mot Applicable

v Update this collection on a schedule
Occurs every 1 day(s) effective 31/08/2009 12:15

Schedule...

0K I Cancel | Apply | Help

© Copyright 2011 Intel Corporation

Figure 62 - Direct Collection Membership Rule Dialog

At the Configuration Manager console, expand System Center Configuration
Manager > Site Database > Computer Management > Operating System
Deployment > Task Sequences

Select the Install Windows 7 Enterprise (x86) task sequence, right-click the
sequence and click Advertise to launch the New Advertisement Wizard

On the General page, use the Browse... button to select to select Windows 7
Deployment for the Collection field. Check the option Make this task sequence
available to boot media and PXE. Click Next

83

Select the Windows 7 Deployment collection, right-click the collection and click
Update Collection Membership. Refresh the collection until the hourglass
disappears from the collection and the Intel vPro client is shown as a member of
the collection
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New Advertisement Wizard N i(_l

%g General

Schedule f Mame: Install Windows 7 Enterprise (x86)

Distribution Points

Interaction

Comment: ZI
Security
Summary
Progress _'
Confirmation
Task sequence: lInstaII ‘Windows 7 Enterprise (x86) Browse... I
Collection: fwindows 7 Deployment Browse... |

V' Include members of subcallections

Task sequences can only be targeted ko computers. Any users or user groups in the selected
collection will be ignored.

< Previous ” MNext = I Fimish I Cancel

Figure 63 - New Advertisement Wizard General Page

e On the Schedule page, click the * button to add mandatory assignments. Select an
appropriate schedule for the mandatory assignment. For this lab, check Assign
immediately after this event and select As soon as possible from the dropdown
box. Click OK to close the Assignment Schedule dialog

Assignment Schedule i x|

" Assign to the following schedule:

Occurs on 21/10/2008 10:36

(% {assign immediately after this event: :

IAs soon as possible ;]

0K I Cancel I Help I

Figure 64 - Advertisement Assignment Schedule Dialog
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New Advertisement Wizard

On the Schedule page, check Enable Wake On LAN, Ignore maintenance
windows when running program and Allow system restart outside
maintenance windows. Click Next

gj Schedule

General

Specify when the program will be advertised to members of the target collection, You can also create

_ an assignment to make the program mandatory.

Distribution Points

Advertisement start time:

85

Interaction

Security I0110912009 :I IH:S4 _—:‘_J u urc
™ advertisement expires:

Summary =
02/03/2010 v |14:34 =

Progress I £ —I I =i Mure

Confirmation Mandatory assignments: - | g | X|

As soon as possible
IV Enable Wake On LAN
v Ignare maintenance windows when running program
IV iallow system restart outside maintenance windows
Priority: IMedium L‘
Program rerun behavior: INever rerun advertised program LI
< Previous ” MNext = I Eirish I Cancel |
Figure 65 - New Advertisement Wizard Schedule Page
e On the Distribution Points page, click Next

On the Interaction page, check the option Show the task sequence progress.

Click Next
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New Advertisement Wizard i 5]

gg Interaction

General
Schedule

Distribution Points

Security ™ allow users to run the program independently of assignments

Specify settings that affect how users are notified about and interact with this advertised program.

Summary
Progress [" | Display reminders according ko the client agent reminder intervals

Confirmation
™ Use custom countdown notification length {minutes): IS 32

< Previous " Next = I FEinishi I Cancel

Figure 66 - New Advertisement Wizard Interaction Page

e On the Security page, click Next
e Onthe Summary page, review the settings and click Next

e On the Confirmation page, click Close

Invoke Out of Band Management Console

e Expand Site Database > Computer Management > Collections

e Select the Windows 7 Deployment collection

¢ Inthe All Systems pane, right-click the client to be managed and click Out of
Band Management > Out of Band Management Console
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£8 Configuration Manager Console ] =10 5[
File Action Y¥iew Window Help | =181 %]
el @
= “S_ite Syste:] All Systems 3 items found Actions
Ex i3 wscc All Systems a2
£l Computer Managemer Look for; I LI in IAII Columns LI Find Moy | Clear | F=y
=) _§ Collections 23] Show Count
& Allactive Dire Q) Update Collection Me...
8 All Desktops a Name | Resource Type | Domain | site Code | client | Approved | as: =
& Al Systems 1 sccm System YPROLAB 15 Mo NiA yes | %3 Install Client
& AllUnknown C Hpco System VPROLAB 15W No NiA ¥e: | 7 Export Objects
&8 All User Grou e
&8 Allusers Install Client ® Nei "
G- Al Windows 2 Distribute. » ;
Delete Special
& Al windows 2 Start » X Delete 5peci
j All Windows M Clear Last PXE Advertisement ] Distribute »
& All windows I Block 3 Tumncfo it i
5 4 , vancfov Cikg Settings
_f All Windows IV Out of Band Ma nent Discover Management Controllers
&8 Al windows I I Power Control XE Advert...
& Al windows Delete Out of Band Management C
Out of Band Management Cc K Seque...
& All Windows 5 Refresh IS
? All Windows S 3 Enable Auditing and Apply Audit Log Settings liguration ...
% Properties )
&8 All windows 4 Disable Audit Log . X
S ) ction Setti,..
G- Al Windows X Help Clear Audit Log
& AMT Systems — = Manage... »
5 Operating Sys Update Pro\fusovlng Data in Management Controller Memory i
3 ; PXE Boot Delete Provisoning Data from Management Controller Memary
'—:lj Conflicting Recorc View 3
(]85 Software Distribut )
(-] Software Updates New Window from Here
-4 Operating System X Delete
-4 Asset Inteligence
-4 Software Metering Refresh -
3} Reporting Properties
3} Desired Configura
& & Queries @ Help
(-7 Mabile Device Mar YPROCLIENT R
(-4 Metwork Access P = )
-7 System Status 43 Install Client
[#-[2 Security Rights ] Distribute >
-[73 Tools =
- Sl | | 3] @ start »
]Launches the out of band management console for this collection resource., [ [

mstartl ey ) H ] Configuration Manag... | &% 9@ 141

Figure 67 - Launch Out of Band Management Console

O Tick this box when you have completed all steps in this procedure

Remotely Boot Client Using PXE

e At the Out of Band Management Console, select Power Control to view the
power control options. This may take 10-20 seconds to complete. If necessary use
the ©* Refresh button
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E‘Dut of Band Management Console t 3 = =] o4

File  Connmection Tools Help
£ LG H
! 5 ; :
.1 System Status Power control allows you to view and update the power state of the computer and set available boot options.

& ' System Information Boot option:

| | Power On NormalB oot
| 3l Power Control IDER
= | BIOS
M | System Event Log Power Dff Intel(r) AMT: Force Hard-drive Boot
= Intellr] AMT: Force CD/DVD Boot
ﬁj IDE-Redirect Log Restart Computer |

!{i System Audit Log ™| Bypass BIOS password
i% Serial Connection I Lock remote keyboard & Boot from local dive & -
Bt file
W Data Storage |
| i3 System: Connected | IDE-Redirect: Inactive | Serial connection: Inactive VYPROCLIENT 192.168.11.32

Figure 68 - Out of Band Console Showing Power Control with PXE Boot Option

e Select Force PXE Boot in the Boot Option: list and click Power On or Restart
Computer. At the Confirmation dialog click Yes. After a few seconds the client
system will boot using PXE

etwork boot from Intel E16880
opyright (C) 2883-2888 UMware, Inc.
opyright (C) 1997-2888 Intel Corporation

LIENT MAC ADDR: 88 BC 29 2E 9B 71 GUID: 564DB327-6F25-EB59-3482-F5BA522E9B71
LIENT IP: 192.168.11.32 MASK: 255.255.255.8 DHCP IP: 192.168.11.2
ATEWAY IP: 192.168.11.1

Downloaded WDSNBP. ..

rchitecture: x86

The details below show the information relating to the PXE boot request for
this computer. Please provide these details to your Hindows Deployment Services
dMministrator so that this request can be approved.

Pending Request ID: 6

ontacting Server: 192.168.11.28.
TFTP Download: smsboot\x86\pxeboot.nl12

Figure 69 - Client Booting from PXE Server

O Tick this box when you have completed all steps in this procedure
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Observe Operating System Installation

e The client will execute the tasks in the advertised task sequence to prepare the
client system and install the Operating System. Installation can take 20-minutes

-- Installation Progress )

gj_ IT Organization
. -3 Running: Install Windows 7 Enterprise (x86)

Running action: Apply Operating System m
EENEEEENEEN

Downloading Windows 7 Enterprise.wim (13% complete)
! (LI

Configuration Manager 2007

Microsi

Figure 70 - Client Executing Windows 7 Installation Task Sequence

O Tick this box when you have completed all steps in this procedure

© Copyright 2011 Intel Corporation



90

Scheduled Operating System Deployment using Intel vPro
Remote Power Control

HELPFUL HINT: Using Intel vPro secure remote power control and ConfigMgr
advertisements to deploy an Operating System works well when it is necessary to
schedule and deploy an Operating System outside of business hours to multiple clients

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

e Shutdown Intel vPro Client

e Create Operating System Deployment Task Sequence

e Add Client to Operating System Deployment Collection

e Advertise Task Sequence To Operating System Deployment Collection
e Observe Client Behaviour

e Observe Operating System Installation

Shutdown Intel vPro Client

e Logon to the Intel vPro client. For this lab logon with username
Administrator@vprolab.com and password of P@sswO0rd

e Shutdown the Intel vPro client so it can be woken up using an ConfigMgr

Advertisement

O Tick this box when you have completed all steps in this procedure

Create Operating System Deployment Task Sequence

HELPFUL HINT: There are no special requirements when creating ConfigMgr
packages or task sequences for use with Intel vPro clients. The virtual machine images
include pre-configured task sequences for use with this exercise
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Refer to ConfigMgr documentation for further details on creating ConfigMgr packages
and task sequences

e Onthe SCCM server, click Start > All Programs > Microsoft System Center >
Configuration Manager 2007 > ConfigMgr Console

e At the Configuration Manager console, expand System Center Configuration
Manager > Site Database > Computer Management > Operating System
Deployment > Task Sequences to see a list of pre-configured task sequences
used in this lab

ls@i Configuration Manager Console i :J.D..I.)g
File Action ¥iew Window Help !;jilﬂ
e | =
5 System Center Configuration a | [N SR e Actions
=163 Site patabase (oW - SO e e ([ Sequences -
& “4? Site Management Look for: | L‘ in |AII Columns LI Eind oW | Clear l
(=454 Computer Managemer MNew »
B Collectlons. | & Import
(-8 All Active Dire Name | Comment | Task 1D | Creation Date: =
S All Desktops a | Boot WinPE ISWO0006 4 Create Task Sequence M...

&8 All Systems
(-8 Al Unknown C
S All User Groug
&8 All Users
-8 Al Windows 2
&8 Al windows 2
&8 Al windows
G- Al Windows I
& Al windows I
&8 All windows I
G- Al Windows I
&8 Al windows 5
& Al windows 5
G- Al Windows ¥
&8 Al windows X
& PXE Boot

G Windows 7 De
G Windows Viste

»EB Conflicting Recorc
#8455 Software Distribut
& z§] Software Updates
[=1-547 Operating System
Lﬁ Boot Images
L@ Computer Ass—
#-55 Operating Sys
L@ Operating Sys
C?_q Task Sequenc
-4y Drivers
L§ Driver Packag
L; Unprovisionec
{4 Asset Intelligence

o) Snftware Metering
< nl »

Install Windows 7 Enterpri )
:| Install Windows Vista Enterprise (x86)

Kl

ISWO00007
ISW00014

28/08/2009 11:27
11:34
31/08/2009 14:33

General | References |

Aél Install Windows 7 Enterprise {x86)

Comment:

Task Id: ISWO00007
Category:

Boot Image: Boot image (x86)

@D Give Feedback
View 4
New Window from Here

Refresh

Properties

@ Help

Install Windows 7 Enterpris... «

2 Edit

j Export

2, Create Task Sequence M...

2% Duplicate

1 Advertise

Ll Move Items

& cut

X Delete

Refresh

Properties

E:@ Help

Figure 71 - Pre-Configured Task Sequences

e Select the Install Windows 7 Enterprise (x86) task sequence, right-click the
sequence and click Edit to launch the Task Sequence Editor
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Install Windows 7 Enterprise (x86) Task Sequence Editor R =10 x|
Add v | Remove (,3 Properties l Options I
B8} Install Operating System Type: I(;mup
2 Restart in Windows PE
& Partition Disk 0 Mame: lInstaIl Operating System
9 Apply OPerating SysFem Description: Actions to run in Windows PE to install and configure
2 Apply Windows Settings = the image

& Apply Network Settings
& Apply Device Drivers ) ) o
|4 Setup Operating System Mo settings are required For this action.
2 Setup Windows and Confighgr
|4 Install Software
2 Install Software
2 Install Software

OK I Cancel | Apply. | Help

Figure 72 - Windows 7 Installation Task Sequence

e Use the Task Sequence Editor to inspect the example task sequence but do not
make any changes for this lab. Click Cancel to close the editor without saving any
changes

O Tick this box when you have completed all steps in this procedure

Add Client to Operating System Deployment Collection

e Expand System Center Configuration Manager > Site Database > Computer
Management > Collections
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File Action View Window Help

© =

olm | @m

2l
&

L
i,

(*] System Center Configuration A

=1+ Site Database (15w - SCC
2 site Management

= Lg Computer Managemer

+- 1€ Network Access P_

{23 Security Rights
73 Topls

R
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&8 All Systems
& All Unknown C
&8 All User Groug.
&8 allusers
& All windows 2
-8 Al Windows 2
@ Al windows ¥
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S8 Al windows
@ Al windows ¥
& All Windows I
&8 Al windows 5
<@ All windows 5
& All Windows 4
&8 Al windows X
& PXE Boot
& Windows 7 De
G Windows Viste
% Conflicting Recorc
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& c‘@ Software Updates
-4 Operating System
[#-14] Asset Inteligence
[+-&m Software Metering
3} Reporting
& Desired Configura
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-7 Mobile Device Mar
[+

System Status

i

£ configuration Manager Console =101 x|
| 181 ]
Collections 20 items found Actions
Collections =
Look for: | _'_I in |AII Columns _'J Find Mow | Clear |
&8 New Collection
'g Export Objects
Mame: | Collection Yariables | Maintenance Windows
&P all Active Directory Security Groups No No QO Update Collection Me...
&# All Desktops and Servers Mo Mo ﬁ Import Objects
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& all Unknown Computers No Mo [ Distribite
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Figure 73 - Windows 7 Deployment Collection

Select the Windows 7 Deployment collection, right-click the collection and click
Properties

At the Windows 7 Deployment Properties dialog, click the Membership Rules
tab and click the Computer icon to launch the Create Direct Membership Rule

Wizard
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Create Direct Membership Rule Wizard

< Brevious: Mext > | st

Figure 74 - Direct Collection Membership Rule Wizard

e Use the wizard to add the Intel vPro client to the membership rules for the
Windows 7 Deployment collection
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Windows 7 Deployment Properties H x|

General Membership Rules ’Adverlisementsl Security |

Collection membership rules determine which resources are included in
the collection when it is updated. & membership rule can be a direct
assignment or a query.

Membership rules: | l ,.l l
- 2 % LJ =] X
vproclient Direct Mot Applicable

v Update this collection on a schedule
Occurs every 1 day(s) effective 31/08/2009 12:15

Schedule...

0K I Cancel | Apply l Help |

Figure 75 - Direct Collection Membership Rule Dialog

e Select the Windows 7 Deployment collection, right-click the collection and click
Update Collection Membership. Refresh the collection until the hourglass
disappears from the collection and the Intel vPro client is shown as a member of

the collection

O Tick this box when you have completed all steps in this procedure

Advertise Task Sequence to Operating System Deployment
Collection

e At the Configuration Manager console, expand System Center Configuration

Manager > Site Database > Computer Management > Operating System
Deployment > Task Sequences
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Figure 76 - Pre-Configured Task Sequences

Select the Install Windows 7 Enterprise (x86) task sequence, right-click the

sequence and click Advertise to launch the New Advertisement Wizard

Deployment for the Collection field. Click Next

© Copyright 2011 Intel Corporation

On the General page, use the Browse... button to select to select Windows 7




New Advertisement Wizard

’
gj General
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Schedule 5 Mame:

Ilnstall Windows 7 Enterprise (x86)

Distribution Points

Interaction

Comment:
Security
Summary
Progress
Confirmation
Task sequence:
Collection: IWindows 7 Deployment

=
IInstall ‘Windows 7 Enterprise (x86) Browse. .. I

Browse...

¥ Include members of subcallections

Task sequences can only be targeted to computers. Any users or user groups in the selected
collection will be ignored.

< Previous ” MNext = I Einish | Cancel

Figure 77 - New Advertisement Wizard General Page

On the Schedule page, click the * button to add mandatory assignments. Select an
appropriate schedule for the mandatory assignment. For this lab, check Assign
immediately after this event and select As soon as possible from the dropdown
box. Click OK to close the Assignment Schedule dialog

Assignment Schedule d x|

" Assign to the Following schedule:

Occurs on 217102008 10:36

Schedule, .,

% PAssign immediately after this event: :

IAs soon as possible :]

OK I Cancel I Help I

Figure 78 - Advertisement Assignment Schedule Dialog
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e On the Schedule page, check Enable Wake On LAN, Ignore maintenance
windows when running program and Allow system restart outside
maintenance windows. Click Next

New Advertisement Wizard

gj Schedule

General

Distribution Points

Interaction
Security
Summary
Progress

Confirmation

Specify when the program will be advertised to members of the target collection, You can also create
an assignment to make the program mandatory.

Advertisement start time:

|o1/09/2009 | 14:34 =l

™ advertisement expires:

Jozfozizoto =] Ji34 = e

Mandatory assignments: ; | Q‘l X|

As soon as possible

IV Enable Wake On LAN

v Ignare maintenance windows when running program

[V liow system restart outside maintenance windows

Priority: IMedium L‘

Program rerun behavior: INever rerun advertised program LI

< Previous ” MNext = I Eirish I Cancel

Figure 79 - New Advertisement Wizard Schedule Page

e On the Distribution Points page, click Next

e On the Interaction page, check the option Show the task sequence progress.

Click Next
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New Advertisement Wizard

gg Interaction

General
Specify settings that affect how users are notified about and interact with this advertised program.
Schedule
Distribution Points
Security ™ allow users to run the program independently of assignments
Summary
Progress [" | Display reminders according ko the client agent reminder intervals
Confirmation
™ Use custom countdown notification length {minutes): ls 3:

< Previous " Mext = I Firish I Cancel
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Figure 80 - New Advertisement Wizard Interaction Page

e On the Security page, click Next
e Onthe Summary page, review the settings and click Next

e On the Confirmation page, click Close

O Tick this box when you have completed all steps in this procedure

Observe Client Behaviour

e ConfigMgr will wake-up the Intel vPro client according to the schedule assigned

to the advertisement

e The ConfigMgr agent will retrieve and process the advertisement. This can take 5

to 10-minutes from the time the client boots to the Operating System
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O Tick this box when you have completed all steps in this procedure

Observe Operating System Installation

e The client will execute the tasks in the advertised task sequence to prepare the
client system and install the Operating System. Installation can take 20-minutes

-. Installation Progress

§] IT Organization
3 Running: Install Windows 7 Enterprise (x86)

Running action: Apply Operating System b
" ARRREENEEER
Microsi o
Downloading Windows 7 Enterprise.wim {13% complete)
S (L]}

Configuration Manager 2007

Figure 81 - Client Executing Windows 7 Installation Task Sequence

O Tick this box when you have completed all steps in this procedure
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Re-Provision Intel vPro Client Management Controller

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

e Change Management Controller Provisioning Configuration
e Re-Provision Intel vPro Client

e Verify Management Controller Changes

Change Management Controller Provisioning Configuration

e On the SCCM server, click Start > All Programs > Microsoft System Center >
Configuration Manager 2007 > ConfigMgr Console

e Expand System Center Configuration Manager > Site Database > Site
Management > ISW > Site Settings > Component Configuration

¢ In the Component Configuration pane, right-click Out of Band Management and
click Properties
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E§ Configuration Manager Console a3t =10] x|
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Figure 82 - Configuration Manager Console Showing Component Configuration

¢ Inthe Out of Band Management Properties dialog, click the AMT Settings tab

e Click the * button to add a Windows domain user or group to the AMT user
accounts list. The domain users or groups added to this list will have access to the
Management Controller on all clients provisioned by this Out of Band Service
Point. For this lab use VPROLAB\HelpDeskAgent as the domain user with
rights to Hardware Information, Event Log Manager, General Information
and Event Log Reader supported AMT features. Click OK to close the AMT
User Account Setting dialog
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AMT User Account Setting 1 x|

Specify the domain account or security group that has permissions to perform
operations on the AMT-based computers.

Account or security group:
Example: domainigroup

IVPROLAB\HeIpDeskAgent Browse... I

Supported AMT features:
I Platform Administration I~ Media Redirection
V' Hardware Information [~ Remote Control

[” Data Storage

[~ Data Storage Administration ™ Agent Presence Local
r Agent Presence Remote o Circuit Breaker

I~ Metwork Time IV General Information
I~ Firmware Update IV Event Log Reader

OK I Cancel ‘ Help |

Figure 83 - VPROLAB\HelpDeskAgent AMT User Account Setting

e Click OK to save the Out of Band Management Properties

Out of Band Management Properties 3 5]

Wired & Wireless Settings I Audit Log I Provision Polling Schedule |
General AMT Settings I Provisioning Settings

Specify settings used to configure Intel AMT-based computers.

AMT user accounts: | _‘_r‘l Xl

Account Name [ rights [
YPROLAB\Domain ... PT Administration,
VYPROLAB\HelpDes... Hardware Information, Event Log Mana...

Default IDE-redirect image
Example: {icontososerver|1SO\Diagnose. 15O

! _mowe.. |

Manageability is OM in the following power state:
IA[ways on (50-55) EI

V' Enable Web interface
[V Enable serial over LAN and IDE redirection
V' allow ping responses

Enable BIOS password bypass for power on and restart
[V commands{requires that the manufacturer has enabled the BIOS
password bypass option for AMT)

I” Enable support For Intel WS-MAN translator

Kerberos clock tolerance (minutes): S -

0K I Cancel | Apply I Help |

Figure 84 - Out of Band Management Properties AMT Settings Tab

O Tick this box when you have completed all steps in this procedure
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Re-Provision Intel vPro Client

Expand Site Database > Computer Management > Collections > All vPro
Systems

Select the All Provisioned vPro Systems collection

In the All Provisioned vPro Systems pane, right-click the client to be re-
provisioned. If more than one client will be re-provisioned hold down the Ctrl key
and click each of the other clients to perform a multiple client selection. Right-
click the selected client and select Out of Band Management > Update
Provisioning Data in Management Controller Memory

At the Update Out of Band Data confirmation dialog, click OK

HELPFUL HINT: If the Management Controller is configured to be active regardless of
client power state, then Management Controller configuration changes can be applied
regardless of client power state thus reducing the overall time for changes to reach
saturation point in an Enterprise environment

O Tick this box when you have completed all steps in this procedure

Verify Management Controller Changes

Allow enough time for the Management Controller re-provisioning process to
complete. For this lab, 1-2 minutes should be sufficient

On the domain controller or SCCM server, open Internet Explorer and enter a
URL of https://vproclient.vprolab.com:16993 to connect to the Management
Controller built-in WebUI on the Intel vPro client. If the browser is unable to
connect to the WebUI, close the browser and use the command ipconfig
[flushdns to flush any residual DNS information. Re-open the browser and retry
connecting to the WebUI

At the WebUI, logon with username VPROLAB\HelpDeskAgent and password
P@sswOrd which were just added to the Intel AMT provisioning configuration
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3 Intel® Active Management Technology - Microsoft Internet Explorer - ﬂl)_g
File Edit Miew Favorites Tools Help ‘ ".'F
QBack » &) ~ |x] 2] A | ) Search - Favorites 421 | Q- B
Address IE:] https:{}vproclient.vprolab.com: 16993findex.htm? _‘_‘1 Go | Links >
Intel®Active Management Technology intel-
Computer: YPROCLIENT ( >
System Status System Status
Hardware Information
System Power oft
Processor P 192.168.11.33
Memary
Disk Systern 1D ©284de32-1287-11dc-bhda-c4al1edb00lc
Event Log Date 512612008
Remote qu{tru!i Time 9:56 am
Power Poli 8
Network Settings& Refresh
User Accounts@ _I
Copyright ® 2005-2007 Intel Corp. Intel® Sctive Management Technology firmware version: 3.2.1-build 1022
|
|&] pone [T [ [@ Trusted sites

Figure 85 - VPROLAB\HelpDeskAgent User WebUI Console

e At the WebUI console note that padlocks on the left-hand navigation bar. This
domain user has restricted access to the Management Controller based on those
properties configured in the Out of Band Management Properties dialog

e Close the browser

O Tick this box when you have completed all steps in this procedure
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Un-Provision Intel vPro Client Management Controller

HELPFUL HINT: Un-provisioning is the process an Enterprise would perform when
clients need to be de-commissioned. Un-provisioning the client Management Controller
removes configuration information and credentials from the Management Controller and
revokes certificates associated with the Management Controller

This exercise consists of the following procedures. The steps that need to be performed to
complete each procedure are described after this list

e Delete Provisioning Data from Management Controller

e Monitor Un-Provisioning Progress of Client Management Controller

Delete Provisioning Data from Management Controller

e On the SCCM server, click Start > All Programs > Microsoft System Center >
Configuration Manager 2007 > ConfigMgr Console

e Expand Site Database > Computer Management > Collections > All vPro
Systems

e Select the All Provisioned vPro Systems collection

e Inthe All Provisioned vPro Systems pane, right-click the client to be un-
provisioned. If more than one client will be un-provisioned hold down the Ctrl
key and click each of the other clients to perform a multiple client selection.
Right-click the selected client and click Out of Band Management > Delete
Provisioning Data from Management Controller Memory

e At the Delete Provisioning Data dialog, check Remove all data from AMT

memory. If you wish to prevent the client from being automatically re-
provisioning then check Disable automatic out of band provisioning. Click OK
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Delete Provisioning Data from jog35 3 x|

This action will remove provisioning information on the AMT-based
! computer and revoke the certificate that was issued to each
AMT-based computer,

Select which data to remove from AMT-based computers, and click
OK; otherwise, click Cancel,

Data removal options

Remove configuration data from AMT memory, and leave AMT
identification data (host name, IP address and DNS suffix)

% Remove all data From AMT memory :

o Disable automatic out of band provisioning

Figure 86 - Delete Provisioning Data Dialog
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Allow sufficient time for the Management Controller un-provisioning process to
complete. For this lab allow 20-30 seconds

Monitor Un-Provisioning Progress of Client Management Controllers

O Tick this box when you have completed all steps in this procedure

Right-click All vPro Systems and click Refresh until the hour glass symbol
disappears from the All vPro Systems collection. The AMT Status column
displays the system provisioning state as Not Provisioned
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Expand Site Database > Computer Management > Collections and right-click
the All vPro Systems collection. Click Update Collection Membership. At the
confirmation request click OK

Allow enough time for collection membership to be updated. For this lab allow
15-30 seconds
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Lab Shutdown

e Shutdown the Virtual machine for the SCCM server

e Shutdown the Virtual machine for the Domain Controller

O Tick this box when you have completed all steps in this procedure
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Appendix A - Virtual Machine Software Inventory

Domain Controller

Windows Server 2008 R2 Enterprise Edition
KB908209 registry changes for Internet Explorer

ConfigMgr Primary Site Server

Windows Server 2008 R2 Enterprise Edition

KB908209 registry changes for Internet Explorer

SQL 2008 Enterprise Edition

System Center Configuration Manager 2007 with Service Pack 2

System Center Service Manager 2010

Intel vPro Processor Management Pack for Microsoft System Center Service
Manager 2010 V1.0

RealVNC VNC Viewer Plus V1.1

Windows Power Shell Module for Intel vPro Technology V3.0
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